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1. Važno

1. Važno
Elektronsko	uputstvo	za	korišćenje	je	
namenjeno	svakom	ko	koristi	Philips	monitor.	
Pažljivo	pročitajte	ovo	uputstvo	pre	nego	što	
počnete	da	koristite	svoj	monitor.	Ono	sadrži	
važne	informacije	i	napomene	koje	se	tiču	rada	
sa	vašim	monitorom.

Garancija	kompanije	Philips	važi	pod	uslovom	
da	se	proizvod	ispravno	upotrebljava	u	svrhe	
za	koje	je	namenjen,	u	skladu	sa	uputstvima	za	
rukovanje	i	uz	prezentaciju	originalne	fakture	
ili	blagajničkog	računa	na	kome	se	vidi	datum	
kupovine,	naziv	prodavnice,	broj	modela	i	serijski	
broj	proizvoda.

1.1 Sigurnosne mere predostrožnosti 
i održavanje

  Upozorenja!
Korišćenje	komandi,	podešavanja	ili	procedura	
drukčijih	od	opisanih	u	ovom	dokumentu	može	
vas	izložiti	strujnom	udaru	i	drugim	električnim	
i/ili	mehaničkim	opasnostima.
Čitajte	i	poštujte	ova	uputstva	kad	priključujete	i	
koristite	svoj	monitor	za	kompjuter :

Operacija
•	 Molimo	čuvajte	monitor	dalje	od	direktne	

sunčeve	svetlosti,	vrlo	jakog	osvetljenja	i	dalje	
od	bilo	kojih	drugih	izvora	toplote.	Duža	
izloženost	ovoj	vrsti	sredine	može	da	dovede	
do	gubljenja	boje	i	oštećenja	monitora.

•	 Uklonite	sve	objekte	koji	bi	mogli	da	upadnu	
u	otvore	za	ventilaciju	ili	da	spreče	pravilno	
hlađenje	elektronskih	delova	monitora.

•	 Nemojte	da	blokirate	otvore	za	ventilaciju	
na	kućištu.

•	 Prilikom	nameštanja	monitora,	proverite	da	
su	utičnica	za	struju	i	priključak	lako	dostupni.

•	 Ukoliko	isključujete	monitor	izvlačenjem	
kabla	za	struju	ili	kabla	za	jednosmernu	
struju,	sačekajte	6	sekundi	pre	pruključivanja	
kabla	za	struju	ili	kabla	za	jednosmernu	
struju	za	normalan	rad.

•	 Molimo	vas	da	uvek	koristite	odobrene	
kablove	za	struju	koje	je	obezbedio	Philips.	
Ukoliko	vaš	kabl	za	struju	nedostaje,	
molimo	vas	da	kontaktirate	svoj	lokalni	
servisni	centar.	(Molimo	vas,	obratite	se	
Informacionom	centru	za	brigu	o	kupcima)

•	 Ne	izlažite	monitor	jakim	vibracijama	ili	
jakim	udarcima	u	toku	rada.

•	 Nemojte	oboriti	ili	ispustiti	monitor	tokom	
rada	ili	transporta.

Održavanje
•	 Da	biste	zaštitili	svoj	monitor	od	mogućeg	

oštećenja,	ne	stavljajte	prekomeran	pritisak	
na	LCD	panel.	Kada	pomerate	svoj	monitor,	
uhvatite	ga	za	okvir	da	biste	ga	podigli;	ne	
podižite	monitor	stavljajući	ruku	ili	prste	na	
LCD	panel.

•	 Isključite	monitor	iz	struje	ukoliko	planirate	
da	ga	ne	koristite	duže	vreme.

•	 Isključite	monitor	iz	struje	ukoliko	želite	
da	ga	očistite	blago	navlaženom	krpom.	
Ekran	možete	očistiti	suvom	krpom	kada	
je	napajanje	isključeno.	Obratite	pažnju	da	
nikada	ne	koristite	organski	rastvor,	poput	
alkohola	ili	tečnosti	baziranih	na	amonijaku,	
za	čišćenje	monitora.

•	 Da	bi	izbegli	rizik	od	šoka	ili	trajnog	
oštećenja,	ne	izlažite	monitor	prašini,	kiši,	
vodi	ili	sredini	u	kojoj	ima	isuviše	vlage.

•	 Ukoliko	se	vaš	monitor	nakvasi,	obrišite	ga	
suvom	krpom	što	je	pre	moguće.

•	 Ukoliko	strana	supstanca	ili	voda	uđu	u	vaš	
monitor,	molimo	vas	da	odmah	isključite	
napajanje	i	izvučete	utičnicu	iz	struje.	
Potom,	uklonite	stranu	supstancu	ili	vodu	i	
pošaljite	monitor	u	servisni	centar.

•	 Ne	stavljajte	i	ne	koristite	monitor	na	
lokacijama	koje	su	izložene	toploti,	
direktnom	suncu	ili	velikoj	hladnoći.

•	 Da	bi	zadržali	vrhunske	karakteristike	svog	
monitora	i	da	bi	on	duže	trajao,	molimo	
vas	da	koristite	monitor	na	mestima	koja	
su	u	sledećem	rasponu	toplote	i	vlažnosti	
vazduha.
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•	 Temperatura:	0-40°C	32-95°F
•	 Vlažnost:	20-80%	RV

Važne informacije o urezanoj/fantomnoj slici
•	 Prilikom	svakog	napuštanja	monitora,	

pokrenite	čuvara	ekrana.	Uvek	aktivirajte	
aplikaciju	za	periodično	osvežavanje	ekrana	
ukoliko	vaš	monitor	prikazuje	nepromenljiv	
statički	sadržaj.	Neprekidno	prikazivanje	
statične	slike	tokom	dužeg	vremenskog	
perioda	može	na	ekranu	da	izazove	efekat	
„urezana	slika”,	takođe	poznat	kao	„slika	
koja	ostaje	na	ekranu”	ili	„fantomna	slika”.

•	 „Urezana	slika”,	„slika	koja	ostaje	na	ekranu”	ili	
„fantomna	slika”	je	dobro	poznati	fenomen	u	
tehnologiji	panel	monitora.	U	većini	slučajeva	
„urezana	slika”,	„slika	koja	ostaje	na	ekranu”	
ili	„fantomna	slika”,	će	nestati	nakon	nekog	
vremena	od	isključenja	iz	struje.

  Upozorenje
Neuspešno	pokretanje	čuvara	ekrana,	ili	
aplikacija	sa	periodičnim	osvežavanjem	ekrana	
mogu	dovesti	do	pojave	ozbiljnih	simptoma	
„urezana	slike”,	„slike	koja	ostaje	na	ekranu”	ili	
„fantomna	slike”,	koji	neće	nestati	i	koji	ne	mogu	
biti	popravljeni.	Oštećenje	pomenuto	gore	nije	
pokriveno	garancijom.

Servisiranje
•	 Otvor	kućišta	treba	da	otvara	isključivo	

osoblje	kvalifikovano	za	servisiranje.
•	 Ukoliko	postoji	potreba	za	bilo	kakvim	

dokumentom	da	bi	se	obavila	popravka	
ili	integracija,	molimo	vas	da	kontaktirate	
svoj	lokalni	centar	za	servisiranje.	(molimo	
vas	da	pogledate	poglavlje	„Centar	za	
informisanje	kupaca”)

•	 Za	informacije	o	transportu,	molimo	vas	
pogledajte	„Tehničke	specifikacije”.

•	 Nemojte	da	ostavite	svoj	monitor	u	kolima/
kamionu	gde	će	biti	direktno	izložen	suncu.

  Beleška
Konsultujte	se	sa	serviserom	ukoliko	monitor	
ne	radi	kako	treba,	ili	ukoliko	niste	sigurni	
koju	proceduru	da	preduzmete	kada	sledite	
instrukcije	date	u	ovom	uputstvu	za	korišćenje.

1.2 Opis oznaka upozorenja
Sledeći	pasusi	opisuju	konvencije	korišćene	u	
ovom	dokumentu	za	oznake	upozorenja.

Pažnja, Oprez, i Upozorenja
Neki	segmenti	teksta	u	ovom	priručniku	praćeni	
su	slikom	i	štampani	su	masnim	slovima	ili	
kurzivom.	Ti	segmenti	sadrže	savete	za	pažnju,	
oprez	i	upozorenja.	Njihovo	značenje	je	sledeće:

  Beleška
Ova	slika	ukazuje	na	važnu	informaciju	ili	savet	
koji	pomaže	da	bolje	iskoristite	svoj	računarski	
sistem.

  Opomena
Ova	slika	ukazuje	na	informaciju	koja	govori	
kako	da	izbegnete	potencijalnu	štetu	na	
hardveru	ili	gubitak	podataka.

  Upozorenje
Ova	slika	ukazuje	na	mogućnost	telesne	
povrede	i	daje	uputstva	kako	da	se	problem	
izbegne.
Neka	upozorenja	mogu	biti	prikazana	bez	
prateće	slike	i	u	drukčijem	formatu.	U	tim	
slučajevima	je	prikaz	upozorenja	propisan	od	
strane	nadležnog	regulativnog	organa.
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1.3 Odbacivanje proizvoda i 
materijala za pakovanje

Odbačena električna i elektronska oprema - 
WEEE

This	marking	on	the	product	or	on	its	
packaging	illustrates	that,	under	European	
Directive	2012/19/EU	governing	used	electrical	
and	electronic	appliances,	this	product	may	
not	be	disposed	of	with	normal	household	
waste.	You	are	responsible	for	disposal	of	
this	equipment	through	a	designated	waste	
electrical	and	electronic	equipment	collection.	
To	determine	the	locations	for	dropping	off	
such	waste	electrical	and	electronic,	contact	
your	local	government	office,	the	waste	disposal	
organization	that	serves	your	household	or	the	
store	at	which	you	purchased	the	product.

Your	new	monitor	contains	materials	that	can	
be	recycled	and	reused.	Specialized	companies	
can	recycle	your	product	to	increase	the	
amount	of	reusable	materials	and	to	minimize	
the	amount	to	be	disposed	of.

All	redundant	packing	material	has	been	
omitted.	We	have	done	our	utmost	to	make	the	
packaging	easily	separable	into	mono	materials.

Please	find	out	about	the	local	regulations	on	
how	to	dispose	of	your	old	monitor	and	packing	
from	your	sales	representative.

Taking back/Recycling Information for 
Customers
Philips	establishes	technically	and	economically	
viable	objectives	to	optimize	the	environmental	
performance	of	the	organization's	product,	
service	and	activities.

From	the	planning,	design	and	production	
stages,	Philips	emphasizes	the	important	of	
making	products	that	can	easily	be	recycled.	At	
Philips,	end-of-life	management	primarily	entails	
participation	in	national	take-back	initiatives	
and	recycling	programs	whenever	possible,	
preferably	in	cooperation	with	competitors,	
which	recycle	all	materials	(products	and	related	
packaging	material)	in	accordance	with	all	
Environmental	Laws	and	taking	back	program	
with	the	contractor	company.

Your	display	is	manufactured	with	high	quality	
materials	and	components	which	can	be	
recycled	and	reused.

To	learn	more	about	our	recycling	program	
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. Podešavanje monitora

2.1 Instalacija

  Sadržaj paketa

* VGA  * DVI

Audio

240S4

Power

©
 2014 Koninklijke Philips N

.V. All rights reserved. Unauthorized duplication is a violation of applicable laws. Made and printed
 in Chin

a. V
ers

ionPhilips and the Philips’ Shield Emblem are registered trademarks of 
Koninklijke Philips N.V. and are used under license from Koninklijke 
Philips N.V.

Monitor drivers
SmartControl software

User’s Manual

  

使用 前请阅读使用说明

保留备用

*	Zavisi	od	države.

  Uklonite postolje
1. Postavite	monitor	licem	naniže	na	meku	

površinu.	Pazite	da	izbegnete	grebanje	i	
oštećivanje	monitora.

2. Umetnite	osnovu	u	prostor	za	VESA	
montiranje.
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3. Držite	monitor	i	osnovu	obema	rukama.
(1)	 Pažljivo	pričvrstite	postolje	za	stub,	

vodeći	računa	da	tri	iglice	ulegnu	u	
otvore.

(2)	 Koristite	svoje	prste	da	pričvrstite	
zavrtnje	koji	se	nalaze	na	dnu	osnove	i	
da	pričvrstite	osnovu	čvrsto	za	stub.

2

1

  Priključivanje na PC

1 2 3

4

6

1

2

3

5

5

1  Priključak	izmenične	struje
2 	DVI	ulaz
3  VGA	ulaz
4  Kensington	brava	protiv	krađe
5  Audio	ulaz
6  Priključak	za	slušalice

Povežite sa kompjuterom
1. Spojite	čvrsto	kabl	za	struju	za	poleđinu	

monitora.
2. Isključite	kompjuter	i	otkačite	njegov	kabl	

za	struju.
3. Povežite	signalni	kabl	monitora	za	video	

konektor	na	zadnjoj	strani	kompjutera.
4. Priključite	kabl	za	napajanje	kompjutera	i	

monitora	u	najbližu	utičnicu.
5. Uključite	kompjuter	i	monitor.	Ako	se	na	

monitoru	pojavi	slika,	instalacija	je	završena.
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2.2 Rad sa monitorom

  Opis kontrolnih dugmadi

7 6 25 4

3

1

Uključivanje	i	isključivanje	
napajanja	monitora.
Pristupanje	meniju	na	ekranu.
Potvrđivanje	podešavanja	menija	
na	ekranu
Podešavanje	menija	na	ekranu.
Izbor	nivoa	SmartPower	
kontrole.

Da	podesite	ton	zvučnika.

Povratak	na	prethodni	nivo	
menija	na	ekranu.
Brzi taster za SmartImage. 
Postoji	6	režima	između	kojih	
možete	da	odaberete:	Office	
(kancelarija),	Photo	(slika),	Movie	
(film),	Game	(igra),	Economy	
(štednja)	i	Off	(isključeno).

  Opis menija na ekranu

Šta je prikaz na ekranu (OSD)?
Prikaz	menija	na	ekranu	(OSD)	je	opcija	
svih	Philips	LCD	monitora.	On	dopušta	da	
krajnji	korisnik	prilagodi	performanse	ekrana	
ili	odabere	funkcije	monitora	direktno	preko	
prozora	sa	uputstvima	koji	se	pojavljuje	na	
ekranu.	Interfejs	menija	na	ekranu	koji	je	
jednostavan	za	korišćenje	prikazan	je	ispod:



Osnovne i jednostavne instrukcije o 
kontrolnim tasterima
U	meniju	prikazanom	iznad,	koristeći	tastere	

 	naprednjem	okviru	monitora	možete	da	
pomerate	pokazivač,	a	pritiskom	na	taster	OK 
da	potvrdite	izbor	ili	izmenu.
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Meni na ekranu
Na	donjoj	skici	prikazana	je	opšta	struktura	
menija	na	ekranu.	Možete	je	koristiti	kao	
referencu	kada	ubuduće	budete	želeli	da	nađete	
sopstveni	put	za	razna	podešavanja.
Main menu Sub menu

Picture

OSD Settings

Setup

Language

Color

Input

Audio

Picture Format

Brightness

Contrast

Horizontal

Vertical

Transparency

OSD Time Out

Auto

V.Position

Phase

Clock

Resolution Notification

Reset

Information

Color Temperature

sRGB

User Define

VGA

DVI

Volume

Mute

Stand-Alone

SmartContrast

Pixel Orbiting

SmartResponse

Gamma

H.Position

Power LED

English, Deutsch, Español, Ελληνική, Français, Italiano,
Maryar, Nederlands, Português, Português do Brazil,
Polski , Русский, Svenska, Suomi, Türkçe, Čeština,
Українська, 简体中文, 繁體中文,日本語,한국어

Wide screen, 4:3

0~100

0~100

0~100

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

On, Off

Yes, No

0~100

0~100

0~100

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100

Green: 0~100

Blue: 0~100

Off, On

Off, On

Off, Fast , Faster, Fastest

On, Off

Off, On

1.8, 2.0, 2.2, 2.4, 2.6 

0~100

0, 1, 2, 3, 4
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  Obaveštenje o rezoluciji
Ovaj	monitor	dizajniran	je	za	optimalan	rad	
pri	nativnoj	rezoluciji	od	1920	x	1200	pri	
60	Hz.	Kade	se	monitor	uključi	u	drugačijoj	
rezoluciji,	pojaviće	se	upozorenje:	Use	
1920	×	1200	@	60	Hz	for	best	results	
(Koristite	1920	x	1200	pri	60	Hz,	za	najbolje	
rezultate).

Prikazivanje	upozorenja	o	osnovnoj	rezoluciji	
može	se	isključiti	u	opciji	Podešavanja	u	
meniju	na	ekranu.

  Fizička funkcija

Nagib

20

-5

Okretanje

-65
65

Podešavanje visine

110mm

Osovinica

0°

90°
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2.3 Uklanjanje sklopa postolja radi 
VESA montiranja

Pre	nego	što	počnete	da	rastavljate	osnovu	
monitora,	molimo	vas	da	pratite	instrukcije	
ispod	da	biste	izbegli	oštećenje	ili	povredu.

1. Postavite	monitor	licem	naniže	na	meku	
površinu.	Pazite	da	izbegnete	grebanje	i	
oštećivanje	monitora.

2. Uklonite	zavrtnje	sa	poklopca	šarki.

1

2

3. Dok	držite	pritisnut	taster	za	otpuštanje,	
nagnite	osnovu	i	izvucite	je.

1

2

4. Uklonite	sklop	postolja.

  Beleška
Ovaj	monitor	prihvata	interfejs	za	montiranje	
dimenzija	100	mm	×	100	mm.

100mm

100mm
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3. Optimizacija slike

3.1 SmartImage

  Šta je to?
SmartImage	nudi	unapred	obavljena	podešavanja	
koja	optimiziraju	ekran	za	razne	vrste	sadržaja,	
dinamično	podešavajući	osvetljenje,	kontrast,	
boju	i	oštrinu	u	stvarnom	vremenu.	Bilo	da	
radite	sa	tekstualnim	aplikacijama,	prikazujete	
slike	ili	gledate	video,	Philips	SmartImage	
isporučuje	optimizovan	rad	monitora.

  Zašto mi je to potrebno?
Želite	monitor	koji	pruža	optimizovan	prikaz	
svih	vaših	omiljenih	tipova	sadržaja,	SmartImage	
softver	dinamično	podešava	osvetljenje,	kontrast,	
boju	i	oštrinu	u	realnom	vremenu	da	bi	povećao	
vaše	uživanje	u	gledanju	monitora.

  Kako radi?
SmartImage	predstavlja	ekskluzivnu,	vodeću	
snagu	Philips	tehnologije	koja	analizira	sadržaj	
prikazan	na	ekranu.	Na	osnovu	scenarija	koji	
ste	odabrali,	SmartImage	dinamično	povećava	
kontrast,	zasićenje	boja	i	oštrinu	slika	da	bi	
poboljšao	prikazani	sadržaj	–	sve	u	realnom	
vremenu,	sa	pritiskom	na	jedan	taster.

  Kako aktivirati SmartImage?

1. Pritisnite	 	da	pokrenete	SmartImage	na	
ekranu.

2. Držite	taster	  	kako	biste	birali	između	
podešavanja	za	Office	(kancelarija),	Photo	

(slika),	Movie	(film),	Game	(igra),	Economy	
(štednja)	i	Off	(isključeno).

3. SmartImage	menija	na	ekranu	će	ostati	
na	ekranu	5	sekundi	ili	možete	takođe	
pritisnuti	„OK”	za	potvrdu.

Postoji	šest	režima	između	kojih	možete	da	odaberete:	
Office	(Kancelarija),	Photo	(slika),	Movie	(film),	Game	
(igra),	Economy	(štednja)	i	Off	(isključeno).









      





•  Office (Kancelarija),:  Poboljšava	tekst	i	
prigušuje	svetlost	kako	bi	se	poboljšala	
čitljivost	i	smanjilo	naprezanje	očiju.	Ovaj	
režim	značajno	poboljšava	čitljivost	i	
produktivnost	kada	radite	sa	tabelama,	PDF	
fajlovima,	skeniranim	člancima	ili	drugim	
opštim	kancelarijskim	aplikacijama.

•  Photo (slika):  Ovaj	profil	kombinuje	
zasićenost	boje,	dinamični	kontrast	i	
poboljšanje	oštrine	za	prikaz	fotografija	
i	drugih	slika	sa	izuzetnom	jasnoćom	u	
rezonantnim	bojama	–	sve	bez	artifekata	i	
zamagljenih	boja.

•  Movie (film):  Pojačana	osvetljenost,	
produbljena	zasićenost	boje,	dinamički	
kontrast	i	britka	oštrina	prikazuju	svaki	
detalj	u	tamnijim	predelima	vaših	snimaka,	
bez	ispiranja	boje	u	svetlijim	predelima,	
zadržavajući	dinamične	prirodne	vrednosti	
za	vrhunski	prikaz	snimaka.

•  Game (igra):  Uključite	kolo	za	najbolje	
vreme	odgovora,	smanjite	reckave	ivice	za	
brzo	pokretne	objekte	na	ekranu,	povećajte	
opseg	kontrasta	za	svetlu	i	tamnu	šemu	
-	ovaj	profil	isporučuje	najbolje	igračko	
iskustvo	za	video	igrice.
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•  Economy (štednja):  U	okviru	ovog	profila,	
svetlost	i	kontrast	su	podešeni,	a	pozadinska	
osvetljenost	je	fino	podešena	za	ispravan	
prikaz	svakodnevnih	kancelarijskih	aplikacija	
i	kako	bi	se	smanjila	potrošnja	energije.

•  Off (Isključeno):  Nema	optimizacije	
pomoću	opcije	SmartImage.

3.2 SmartContrast

  Šta je to?
Jedinstvena	tehnologija	koja	dinamično	analizira	
prikazani	sadržaj	i	automatski	optimizuje	
kontrast	monitora	za	maksimalnu	vizuelnu	
jasnoću	i	uživanje	u	gledanju,	pojačavajući	
pozadinsko	osvetljenje	za	jasnije,	oštrije	i	svetlije	
slike,	ili	zatamnjujući	pozadinsko	osvetljenje	za	
jasniji	prikaz	slika	na	tamnim	pozadinama.

  Zašto mi je to potrebno?
Želite	najbolju	vizuelnu	jasnoću	i	uživanje	u	
gledanju	svake	vrste	sadržaja.	SmartContrast	
(Smart	kontrast)	dinamično	kontroliše	kontrast	i	
podešava	pozadinsko	osvetljenje	za	jasnije,	oštrije	
i	svetlije	igranje	igrica	i	video	slika	ili	prikazuje	jasan,	
čitljiv	tekst	za	kancelarijski	rad.	Smanjujuci	električnu	
potrošnju	vašeg	monitora,	štedite	troškove	energije	
i	produžujete	život	svog	monitora.

  Kako radi?
Kada	aktivirate	SmartContrast	(pametni	kontrast),	
on	će	analizirati	sadržaj	koji	prikazujete	u	realnom	
vremenu	radi	podešavanja	boje	i	kontrole	
intenziteta	pozadine.	Ova	funkcija	će	dinamično	
povećati	kontrast	radi	velikog	iskustva	u	zabavi	
prilikom	gledanja	video	zapisa	ili	igranja	igrica.

3.3 Philips SmartControl Premium
Novi	SmartControl	Premium	softver	kompanije	
Philips	vam	omogućava	da	upravljate	svojim	
monitorom	preko	grafičkog	interfejsa	na	ekranu	
koji	se	lako	koristi.	Komplikovana	podešavanja	su	
stvar	prošlosti	dok	vas	ovaj	jednostavni	softver	
vodi	kroz	fino	podešavanje	rezolucije,	kalibraciju	

boje,	podešavanje	sata/faze,	podešavanja	RGB	
bele	tačke,	itd.

Opremljen	najnovijom	tehnologijom	u	jezgru	
algoritma	za	brzu	obradu	i	odgovore,	ovaj	
primamljivi	softver,	baziran	na	animiranim	
ikonicama,	kompatibilan	sa	Windows	7	
sistemom,	je	tu	da	poboljša	vaše	iskustvo	sa	
Philips	monitorima!

  Instalacija
•	 Sledite	uputstva	i	obavite	instalaciju.
•	 Možete	da	ga	pokrenete	kada	završite	sa	

instalacijom.
•	 Ukoliko	želite	da	pokrenete	softver	kasnije,	

možete	kliknuti	na	prečicu	na	desktopu	ili	
na	liniji	sa	alatkama.

Čarobnjak za prvo pokretanje
•	 Prvi	put	nakon	instaliranja	SmartControl	

Premium,	program	će	automatski	otići	do	
čarobnjaka	za	pokretanje	po	prvi	put.

•	 Čarobnjak	će	vas	voditi	kroz	podešavanja	
performansi	vašeg	monitora,	korak	po	
korak.

•	 Možete	takođe	ići	i	na	Plug-in	(priključci)	
meni	da	pokrenete	čarobnjaka	kasnije.

•	 Možete	podešavati	više	opcija	bez	
čarobnjaka,	preko	Standard	(standardnog)	
prozora.
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  Počnite sa Standard (standardnim) 
prozorom

Adjust menu (Meni za podešavanje)
•	 Meni	Adjust	(podešavanja)	omogućava	

vam	da	podesite	Brightness	(osvetljenje),	
Contrast	(kontrast)	i	Resolution	(rezoluciju).

•	 Možete	slediti	uputstva	i	obaviti	
podešavanje.

•	 Cancel	(Otkažite)	poruke	ukoliko	želite	da	
otkažete	instalaciju.

Meni za Color (boje)
•	 Meni	Color	(boja)	omogućava	vam	da	

podesite	RGB,	Black	Level	(nivo	crne),	
White	Point	(belu	tačku),	Display	Gamma	
(opseg	boja),	Color	Calibration	(kalibraciju	
boje),	SmartImage	i	SmartColor.

•	 Možete	slediti	uputstva	i	obaviti	
podešavanje.

•	 Pogledajte	tabelu	ispod	za	osnovne	stavke	
pod-menija	na	svom	ulazu.

•	 Primer	za	Color	Calibration	(kalibraciju	
boje).
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1. „Show	Me”	(Pokaži	mi)	startuje	priručnik	za	
kalibraciju	boje.

2. Start	(Početak)	-	startuje	sekvencu	od	6	
koraka	za	kalibraciju	boje.

3. Quick	View	(Brzi	pregled)	učitava	
prethodne/naredne	slike.

4. Da	biste	se	vratili	na	početni	ekran	menija	
Color	(boja),	kliknite	na	dugme	Cancel (otkaži).

5. Enable	color	calibration	(Aktivirajte	
kalibraciju	boje)	–	po	fabričkom	podešavanju	
je	uključena.	Ukoliko	nije	označeno,	ne	
dozvoljava	kalibraciju	boje,	zatamnjuje	tastere	
Start	(Početak)	i	Quick	View	(Brzi	pregled).

6. Morate	imati	informacije	o	patentu	na	
ekranu	za	kalibraciju.
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Prvi ekran za kalibraciju boje

•	 Previous	(Prethodni)	taster	je	deaktiviran	
do	drugog	ekrana	za	boju.

•	 Next	(Dalje)	odlazi	na	sledeći	cilj	(6-ciljeva).
•	 Na	kraju,	idite	na	prozor	File	>	Presets	(Fajl	

>	Unapred	podešene	vrednosti).
•	 Cancel	(Otkaži)	zatvara	UI	i	vraća	na	

stranicu	Plug-in	(priključci).

SmartImage
Omogućava	korisnicima	da	promene	
podešavanja	za	bolju	postavku	prikaza	u	
zavisnosti	od	sadržaja.

Kada	se	podesi	Entertainment	(Zabava),	
SmartContrast	i	SmartResponse	su	aktivirani.

Meni Eco Power

Meni sa opcijama
Options > Preferences (Opcije > Preference)–	Biće	
aktivno	samo	izborom	Preferences	(Preferenci)	iz	
padajućeg	menija	Options	(Opcije).	Na	nepodržanom	
ekranu	koji	je	sposoban	za	DDC/CI,	samo	su	prozori	
Help	(Pomoć)	i	Options	(Opcije)	dostupni.

•	 Prikazuje	trenutna	podešavanja	preferenci.
•	 Označen	kvadratić	omogućava	opciju.	Kvadrat	

za	označavanje	može	da	se	uključi	i	isključi.
•	 Enable	Context	Menu	(Aktiviraj	Kontekst	meni)	

na	desktopu	je	označeno	(Da)	prema	fabričkom	
podešavanju.	Enable	Context	menu	(Omogućavanje	
kontekst	menija)	prikazuje	SmartControl	Premium	
izbore	za	Select	Preset	(Odabiranje	podešavanja	
unapred)	i	Tune	Display	(Podešavanje	ekrana)	u	
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kontekst	meniju,	prilikom	desnog	klika	desktop.	
Onemogućeno	uklanja	SmartControl	Premium	sa	
kontekst	menija,	prilikom	desnog	klika.

•	 Ikona	Enable	Task	Tray	(Aktiviraj	trej	sa	zadacima)	
je	označena	(Da)	prema	fabričkom	podešavanju.	
Omogućavanje	kontekst	menija	prikazuje	meni	
treja	sa	zadacima	za	SmartControlPremium.	
Desnim	klikom	na	ikonu	treja	sa	zadacima	
prikazuju	se	opcije	menija	za	Help	(Pomoć),	
Technical	Support	(Tehničku	podršku).	Check	
for	Update	(Proveri	ažurnost),	About	(O)	i	Exit	
(Izlaz).	Kada	se	meni	Enable	Task	Tray	(Aktiviraj	
trej	sa	zadacima)	deaktivira,	ikona	za	trej	sa	
zadacima	će	pokazivati	samo	Exit	(Izlaz).

•	 Pokreni	na	početku	je	označeno	(Da),	prema	
fabričkom	podešavanju.	Kada	se	onemogući,	
SmartControl	Premium	se	neće	pokrenuti	
pri	startu	i	neće	biti	u	treju	sa	zadacima.	
Jedini	način	da	se	pokrene	SmartControl	
Premium	je	sa	prečice	na	desktopu	ili	
preko	programskog	fajla.	Svako	prethodno	
podešavanje	podešeno	na	pokretanje	pri	
startu	neće	funkcionisati	kada	ovaj	prozor	nije	
označen	(Deaktiviran).

•	 Omogućite	režim	transparentnosti	(Windows	
7,	Vista,	XP).	Osnovno	je	0%	neprozirno.

Options >Audio (Opcije >Audio)	–	Biće	
aktivno	samo	kada	se	izabere	Audio	iz	padajućeg	
menija	Options	(Opcije).

Na	nepodržanom	ekranu	koji	je	sposoban	
za	DDC/CI,	samo	su	prozori	Help	(Pomoć)	i	
Options	(Opcije)	dostupni.

Option > Auto Pivot (Opcija > Auto osovinica)

Options > Input (Opcije >Unos)	–	Biće	aktivno	
samo	kada	izaberete	Input	(Unos)	iz	padajućeg	
menija	Options	(Opcije).	Na	nepodržanom	
ekranu	koji	je	sposoban	za	DDC/CI,	samo	
su	prozori	Help	(Pomoć)	i	Options	(Opcije)	
dostupni.	Nijedna	druga	SmartControl	Premium	
tabela	nije	dostupna.

•	 Prikazuju	prozor	Source	(Izvorno)		
uputstvo	i	podešavanje	izvora	trenutnog	
unosa.

•	 Na	ekranima	sa	jednim	ulazom,	ovaj	prozor	
neće	biti	vidljiv.
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Options > Theft Deterrence (Opcije > 
Sprečavanje krađe)	-	Ekran	za	sprečavanje	
krađe	će	biti	aktivan	samo	kada	odaberete	
režim	za	Theft	Deterrence	(Sprečavanje	krađe)	
sa	padajućeg	menija	Plug-in	(priključci).

Da	biste	omogućili	Theft	Deterrence	(Sprečavanje	
krađe),	kliknite	na	dugme	(Uključi)	da	biste	otvorili	
sledeći	ekran:

•	 Korisnik	može	uneti	PIN	od	samo	između	
4	i	9	cifara.

•	 Nakon	unosa	PIN-a,	taster	Accept	(Prihvati)	
dovodi	korisnika	do	prozorčića	na	sledećoj	strani.

•	 Minimalno	minuta	je	podešeno	na	5.	Klizač	je	
podešen	na	5	prema	osnovnom	podešavanju.

•	 Ne	zahteva	da	se	ekran	prikači	za	drugog	
domaćina	da	bi	se	ušlo	u	režim	za	Theft	
Deterrence	(Sprečavanje	krađe).

Nakon	kreiranja	PIN-a,	prozor	Theft	Deterrence	
(Sprečavanje	krađe)	će	pokazati	Theft	
Deterrence	(Sprečavanje	krađe)	aktivirano	i	
daće	taster	PIN	Options	(PIN	opcije):

•	 Theft	Deterrence	(Sprečavanje	krađe)	
aktivirano	je	prikazano.

•	 Onemogućevanje	režima	za	Theft	
Deterrence	(Sprečavanje	krađe)	otvara	
ekran	na	sledećoj	strani.

•	 Taster	PIN	Options	(PIN	opcije)	dostupan	
je	samo	nakon	kreiranja	PIN-a,	i	otvara	
bezbednu	PIN	internet	prezentaciju.

Meni za Help (Pomoć)
Help > User Manual (Pomoć > Uputstvo 
za korišćenje)	-	Biće	aktivno	samo	kada	se	
izabere	User	Manual	(uputstvo	za	korišćenje)	
iz	padajućeg	menija	Help	(pomoć).	Na	
nepodržanom	ekranu	koji	je	sposoban	za	DDC/
CI,	samo	su	prozori	Help	(Pomoć)	i	Options	
(Opcije)	dostupni.

Help > Version (Pomoć > Verzija)-	Biće	
aktivno	samo	kada	se	izabere	Version	(Verzija)	
iz	padajućeg	menija	Help	(Pomoć).	Na	
nepodržanom	ekranu	koji	je	sposoban	za	DDC/
CI,	samo	su	prozori	Help	(Pomoć)	i	Options	
(Opcije)	dostupni.
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Context Sensitive Menu (Meni osetljiv na kontekst)
Context	Sensitive	Menu	(Meni	osetljiv	na	kontekst)	
je	Aktiviran	prema	fabričkom	podešavanju.	Ukoliko	
je	Enable	Context	Menu	(Aktiviraj	kontekst	meni)	
označen	u	prozoru	Options	>	Preferences	(Opcije	
>	Preference),	onda	će	meni	biti	vidljiv.

Context	Menu	(Kontekst	meni)	ima	četiri	ulaza:

•  SmartControl Premium	-	Kada	je	odabrano,	
prikazan	je	About	(O)	ekranu.

•  Select Preset (Izaberi podešavanja unapred)	–	
Nudi	hijerarhijski	meni	sačuvanih	podešavanja	
unapred	za	trenutnu	upotrebu.	Znak	za	oznaku	
pokazuje	trenutno	izabrano	podešavanje	
unapred.	Factory	Preset	(Fabričko	podešavanje)	
se	takođe	mogu	pozvati	iz	padajućeg	menija.

•  Tune Display (Podesite prikaz)	-	Otvara	
SmartControl	Premium	kontrol	panel.

•  SmartImage	–	Provera	aktivnih	podešavanja:	
Off	(Isključeno),	Office	(Kancelarija),	Photo	
(Fotografija),	Movie	(Film),	Game	(Igra),	
Economy	(Štednja).

Meni treja sa zadacima je aktiviran
Meni	treja	sa	zadacima	može	da	se	prikaže	klikom	
na	SmartControl	Premium	ikonicu,	sa	trake	sa	
zadacima.	Levi	klik	će	pokrenuti	aplikaciju.

Trej	sa	zadacima	ima	pet	ulaza:

•  Help (Pomoć)	–	Pristup	fajlu	Uputstvo	
za	korišćenje:	Otvorite	fajl	Uputstvo	
za	korišćenje	koristeći	prozor	
podrazumevanog	pretraživača.

•  Technical Support (Tehnička podrška)	–	
Prikazuje	stranicu	za	tehničku	podršku.

•  Check for Update (Proveri ažurnost) –	
Vodi	korisnika	na	PDI	početnu	stranicu	i	
proverava	da	li	je	dostupna	novija	verzija	od	
korisnikove.

•  About (O)	–	Prikazuje	detaljne	referentne	
informacije:	Verziju	proizvoda,	podatke	o	
stavljanju	u	promet	i	naziv	proizvoda.

•  Exit (Izlaz)	-	zatvorite	SmartControl	Premium
Da	biste	ponovo	pokrenuli	SmartControl	
Premium,	odaberite	SmartControl	Premium	
sa	menija	Program,	dvokliknite	na	desktop	PC	
ikonicu,	ili	ponovo	pokrenite	sistem.

Meni treja sa zadacima je deaktiviran
Kada	se	trej	sa	zadacima	deaktivira	u	folderu	
za	preference,	dostupan	je	samo	izbor	Exit	
(Izlaz).	Da	u	potpunosti	uklonite	SmartControl	
Premium	sa	treja	sa	zadacima,	onemogućite	
Run	at	Startup	(Pokreni	pri	startu)	u	Options	>	
Preferences	(Opcije	>	Preferiranja).

  Beleška
Sve	slike	u	ovom	odeljku	prikazane	su	kao	
reference.	Verzija	SmartControl	softvera	može	
da	se	promeni	bez	obaveštenja.	Uvek	posetite	
zvanični	Portrait	sajt	na	adresi	www.portrait.
com/dtune/phl/enu/index	da	biste	preuzeli	
najnoviju	verziju	SmartControl	softvera.

www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index
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3.4 Vodič za SmartDesktop

  SmartDesktop
SmartDesktop	se	nalazi	u	SmartControl	
Premium.	Instalirajte	SmartControl	Premium	i	
izaberite	SmartDesktop	iz	Options	(Opcija).

•	 Polje	za	potvrdu	za	Align	to	partition	
(Poravnanje	uz	particiju)	omogućiće	
automatsko	poravnanje	za	prozor	kada	se	
prevuče	na	definisanu	particiju.		 	

•	 Izaberite	željenu	particiju	klikom	na	ikonu.	
Particija	će	biti	primenjena	na	radnu	
površinu,	a	ikona	će	biti	istaknuta.

•	 Opcija	Identify	(Identifikuj)	je	brzi	način	da	
se	prikaže	mreža.

Prevlačenje i puštanje prozora
Kada	su	particije	konfigurisane	i	kada	je	izabrano	
polje	Align	to	partition	(Poravnaj	uz	particiju),	
prozor	se	može	prevući	u	taj	deo	i	biće	

automatski	poravnat.	Kada	se	prozor	i	kursor	
miša	nalaze	u	tom	delu,	deo	postaje	istaknut.

  Beleška
Ako	spoljni	deo	nije	vidljiv	kada	se	prevlači	
prozor,	znači	da	je	onemogućena	opcija	„Show	
windows	contents	while	dragging	(Prikaži	
sadržaje	prozore	pri	prevlačenju)”.	Da	biste	
omogućili:

1. U	Control	Panel	(Kontrolnom	panelu)	
kliknite	na	System	(Sistem).

2. Kliknite	na	Advanced	system	settings	
(Napredne	postavke	sistema)	(Kod	OS	
Vista	i	Win7,	to	se	nalazi	na	levoj	bočnoj	
traci).

3. U	delu	Performance	(Performanse)	kliknite	
na	Settings	(postavke).

4. U	kvadratiću	za	potvrdu,	označite	Show	
window	contents	while	dragging	(Prikaži	
sadržaje	prozora	tokom	prevlačenja)	i	
kliknite	na	OK.

Druga, alternativna putanja:

Vista:
Control	Panel	(Kontrolna	tabla)	>	
Personalization	(Personalizacija)	>	Window	
Color	and	Appearance	(Boja	i	izgled	prozora)	>	
Kliknite	na	„Open	Classic	appearance	properties	
for	more	color	options”	(Otvori	svojstva	
klasičnog	izgleda	za	više	opcija	boja)	>	Kliknite	
na	dugme	„Effects”	(Efekti)	>	potvrdite	izbor	
u	polju	Show	window	contents	while	dragging	
(Prikaži	sadržaj	prozora	pri	prevlačenju).

XP:
Display	Properties	(Svojstva	prikaza)	>	
Appearance	(Izgled)	>	Effects...	(Efekti...)	
>	označite	opciju	Show	window	contents	
while	dragging	(prikaži	sadržaje	prozora	pri	
prevlačenju).

Win 7:
Druge	putanje	nisu	dostupne.
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  Opcije za naslovnu traku
Pristup	opciji	Desktop	partition	(Particija	radne	
površina)	je	moguć	preko	naslovne	trake	aktivnog	
prozora.	To	omogućava	brz	i	lak	način	da	se	upravlja	
radnom	površinom	kao	i	slanjem	bilo	kog	prozora	
u	bilo	koju	particiju	bez	potrebe	za	prevlačenjem	
i	puštanjem.	Pomerite	kursor	na	naslovnu	traku	
aktivnog	prozora	da	biste	pristupili	padajućem	meniju.

  Desni klik mišem
Desnim	tasterom	miša	kliknite	na	ikonu	
Desktop	Partition	(Particija	radne	površine)	da	
biste	prikazali	padajući	meni.

•	 Find Windows (Pronađi prozore)	–	U	nekim	
slučajevima	korisnik	može	da	pošalje	više	prozora	
na	istu	particiju.	Opcija	Find	Window	(Pronađi	
prozor)	će	prikazati	sve	otvorene	prozore	i	
pomeriti	izabrani	prozor	u	prednji	plan.

•	 Desktop Partition (Particija radne površine) 
–	Desktop	Partition	(Particija	radne	površine)	
prikazuje	trenutno	izabranu	particiju	i	
omogućava	korisniku	da	brzo	pređe	na	bilo	koju	
particiju	koja	je	prikazana	u	padajućem	meniju.

  Beleška
Ako	je	priključeno	više	od	jednog	ekrana,	
korisnik	može	da	izabere	ciljni	ekran	da	bi	
promenio	particiju.	Istaknuta	ikona	predstavlja	
trenutno	aktivnu	particiju.

•	 Identify Partition (Identifikuj particiju) 
–	Prikazuje	spoljnu	mrežu	za	trenutnu	
particiju	na	radnoj	površini	.

•	 Align On/Align Off (Poravnanje 
uključeno/Poravnanje isključeno) 
–	Omogućava/onemogućava	opciju	
automatskog	poravnanja	pri	prevlačenju	i	
puštanju.

•	 Exit (Izlaz)	–	Zatvara	aplikaciju	Desktop	
Partition	(particija	radne	površine)	i	
Display	Tune	(podešavanje	ekrana).	Da	
biste	ih	ponovo	otvorili,	pokrenite	Display	
Tune	(Podešavanje	ekrana)	iz	menija	start	
(početak),	ili	putem	prečice	na	radnoj	
površini.

  Levi klik mišem
Levim	tasterom	miša	kliknite	na	ikonu	Desktop	
Partition	(Particija	radne	površine)	da	biste	
aktivan	prozor	brzo	poslali	na	bilo	koju	particiju	
bez	potrebe	za	prevlačenjem	i	puštanjem.	Kada	
se	miš	pusti,	prozor	će	biti	poslat	na	istaknutu	
particiju.

  Desni klik na trej sa zadacima
Trej	sa	zadacima	takođe	sadrži	većinu	opcija	
koje	su	podržane	u	naslovnoj	traci	(osim	
automatskog	slanja	prozora	na	bilo	koju	
particiju).
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•	 Find Windows (Pronađi prozore)	–	U	
nekim	slučajevima	korisnik	može	da	
pošalje	više	prozora	na	istu	particiju.	
Opcija	Find	Window	(Pronađi	prozor)	će	
prikazati	sve	otvorene	prozore	i	pomeriti	
izabrani	prozor	u	prednji	plan.

•	 Desktop Partition (Particija radne 
površine)	–	Desktop	Partition	(Particija	
radne	površine)	prikazuje	trenutno	
izabranu	particiju	i	omogućava	korisniku	
da	brzo	pređe	na	bilo	koju	particiju	koja	je	
prikazana	u	padajućem	meniju.

•	 Identify Partition (Identifikuj particiju) 
–	Prikazuje	spoljnu	mrežu	za	trenutnu	
particiju	na	radnoj	površini	.

•	 Align On/Align Off (Poravnanje 
uključeno/Poravnanje isključeno) 
–	Omogućava/onemogućava	opciju	
automatskog	poravnanja	pri	prevlačenju	i	
puštanju.
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  Definicije SmartDesktop particije

Naziv Opis Slika
Full	Desktop	 
(Cela	radna	površina)

Primenjuje	sve	postavke	na	celu	radnu	površinu.

Vertical	(Vertikalno) Procenjuje	rezoluciju	ekrana	i	deli	displej	na	dva	
vertikalna	dela	jednake	veličine.

Kod	90/270,	održava	vertikalnu	konfiguraciju.

Horizontal	
(Horizontalno)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	dva	
horizontalna	dela	jednake	veličine.

Kod	90/270,	održava	horizontalnu	konfiguraciju.

Vertical	Triple	 
(Tri	vertikale)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	tri	vertikalna	
dela	jednake	veličine.

Kod	90,	particija	1	horizontalno	gore,	particija	2	
horizontalno	u	sredini,	particija	3	horizontalno	dole.
Kod	270,	particija	3	horizontalno	gore,	particija	2	
horizontalno	u	sredini,	particija	1	horizontalno	dole.

Vertical	Split	Left	
(Vertikalno	sa	
deljenjem	levo)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	dva	
vertikalna	dela,	levo	-	jedan	deo,	desno	-	podela	na	dva	
dela	jednake	veličine.
Kod	90,	particija	1	je	gore,	particija	2	i	3	dole.	Kod	270,	
particija	1	dole,	particija	2	i	3	gore.

Vertical	Split	Right	
(Verikalno	sa	
deljenjem	desno)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	dva	
vertikalna	dela,	desno	-	jedan	deo,	levo	-	podela	na	dva	
dela	jednake	veličine.
Kod	90,	particija	1	i	2	su	gore,	particija	3	dole.	Kod	270,	
particija	3	je	gore,	particija	1	i	2	dole.
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Naziv Opis Slika
Horizontal	Split	Top	
(Horizontalno	sa	
podelom	gore)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	dva	jednaka	
horizontalna	dela,	od	kojih	je	jedan	deo	gore,	a	donji	
deo	je	podeljen	na	dva	dela	jednake	veličine.
Kod	90,	particija	1	je	na	desnoj	strani,	vertikalna	particija	
2	i	3	na	levoj	strani	vertikalno.
Kod	270	Particija	1	na	levoj	strani,	vertikalna	particija	2	i	
3	na	desnoj	strani	vertikalno.

Horizontal	Split	
Bottom	(Horizontalno	
sa	podelom	dole)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	dva	jednaka	
horizontalna	dela,	od	kojih	je	jedan	deo	gore,	a	donji	
deo	je	podeljen	na	dva	dela	jednake	veličine.	Kod	90,	
particija	1	i	2	na	desnoj	strani,	vertikalna	particija	3	na	
levoj	strani	vertikalno.	Kod	270,	particija	1	i	2	na	levoj	
strani,	vertikalna	particija	3	na	desnoj	strani	vertikalno.

Even	Split	
(Podjednaka	podela)

Procenjuje	rezoluciju	ekrana	i	deli	prikaz	na	četiri	dela	
jednake	veličine.
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4. Tehničke specifikacije
Slika/Prikaz
Tip	ekrana	monitora PLS
Pozadinsko	svetlo SVETLEĆA	DIODA
Veličina	panela 24''	Š	(61cm)
Format	slike: 16:10
Razdoblje	piksela 0,270	x	0,270	mm
Osvetljenje 250	cd/m²
SmartContrast 20.000.000:1
Opseg	kontrasta	(tip.) 1000:1
Vreme	odziva 15 ms
SmartResponse 5	ms	(GTG)
Optimalna	rezolucija 1920	x	1200	pri	60Hz
Ugao	gledanja 178°	(H)	/	178°	(V)	pri	C/R	≥	10
Prikaz	boja 16,7M
Vertikalna	frekvencija	
osvežavanja 56 - 76 Hz

Horizontalna	frekvencija 30 - 83 kHz
sRBG DA
Povezivanje
Ulaz	za	signal DVI	(digitalni),	VGA	(analogni),

Ulazni	signal Odvojeni	Sync	(sinhronizacioni	impuls),	Sync	(sinhronizacioni	
impuls)	na	zelenom

Audio	Ulaz/Izlaz Ulaz	za	PC	audio,	izlaz	za	slušalice
Ugodnost
Ugrađeni	zvučnici 1,5	W	(Iznad)	×	2
Pogodnosti	za	korisnika  

Jezici	menija	na	ekranu

Engleski,	nemački,	španski,	grčki,	francuski,	italijanski,	mađarski,	
holandski,	portugalski,	brazilski	portugalski,	poljski,	ruski,	švedski,	
finski,	turski,	češki,	ukrajinski,	pojednostavljeni	kineski,	tradicionalni	
kineski,	japanski,	korejski

Druge	pogodnosti Kensington	brava
Plug	and	Play	kompatibilnost DDC/CI,	sRGB,	Windows	8/7/Vista/XP,	Mac	OSX,	Linux
Stalak
Nagib -5	/	+20	
Okretanje -65/+65
Podešavanje	visine 110mm
Napajanje
Režim	je	uključen 29,8	W	(tip.)	48	W	(maks.)
Spavanje	(vreme	čekanja) <0,3	W
Isključeno <0,2	W
Režim	uključenosti	(EKO	režim) 17,3	W	(tip.)
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Napajanje (EnergyStar probni metod)

Potrošnja	energije Ulazni	napon	AC	
na	100VAC,	50Hz

Ulazni	napon	AC	
na	115VAC,	60Hz

Ulazni	napon	AC	
na	230VAC,	50Hz

Normalan	rad 23,75W	(tip.) 23,59W	(tip.) 23,67W	(tip.)
Spavanje	(vreme	čekanja) 0,17W	(tip.) 0,17W	(tip.) 0,21W	(tip.)
Isključeno 0,13W	(tip.) 0,13W	(tip.) 0,16	W	(tip.)

Rasipanje	toplote* Ulazni	napon	AC	
na	100VAC,	50Hz

Ulazni	napon	AC	
na	115VAC,	60Hz

Ulazni	napon	AC	
na	230VAC,	50Hz

Normalan	rad 81,05	BTU/hr	(tip.) 80,51	BTU/hr	(tip.) 80,78	BTU/hr	(tip.)
Spavanje	(vreme	čekanja) 0,59	BTU/hr	(tip.) 0,59	BTU/hr	(tip.) 0,73	BTU/hr	(tip.)
Isključeno 0,43	BTU/hr	(tip.) 0,43	BTU/hr	(tip.) 0,55	BTU/hr	(tip.)
Svetleća	dioda	za	pokazivanje	
napajanja

Režim	je	uključen:	Belo,	režim	za	čekanje/spavanje:	Belo	
(trepćuće)

Napajanje Ugrađeno,	100–240	VAC,	50–60	Hz
Dimenzije
Proizvod	sa	postoljem	(ŠxVxD) 555×543×227 mm
Proizvod	bez	postolja	(ŠxVxD) 555×388×65 mm
Težina
Proizvod	sa	postoljem 6,34	kg
Proizvod	bez	postolja 4,48	kg
Stanje rada
Raspon	temperature	(rada) Od	0°C	do	40°C
Temperaturni	opseg
(Kada	ne	radi)	 Od	-20°C	do	60°C

Relativna	vlažnost Od	20%	do	80%
Srednje	vreme	do	otkaza 40.000 sati
Okruženje
ROHS DA
EPEAT Zlato	(www.epeat.net)
Packaging 100%	se	može	reciklirati
Posebne	substance Kućište	100%	bez	PVC-a	i	BFR-a
EnergyStar DA
Usklađenost sa standardima

Regulatorna	odobrenja CE	oznaka,	FCC	klase	B,	SEMKO,	UL/cUL,	CU-EAC,	 
TCO	sertifikat,	TUV-GS,	TUV-ERGO

Kutija
Obojeni Crna/Srebrna
Završna	obrada Tekstura

  Beleška
1. EPEAT	zlato	i	srebro	važi	samo	tamo	gde	Philips	registruje	proizvode.		Molimo	posetite	www.epeat.

net	za	status	registracije	u	vašoj	državi.

http://www.epeat.net
http://www.epeat.net
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2. Ovi	podaci	se	mogu	menjati	bez	
obaveštenja.	Idi	na	www.philips.com/support 
da	preuzmete	najnoviju	verziju	pamfleta.

3.	 Vreme	inteligentnog	odziva	je	optimalna	
vrednost	izmerena	na	GtG	ili	GtG	(BW)	
testu.

4.1 Rezolucija i unapred podešeni 
režimi

  Maksimalna rezolucija
1920	x	1200	pri	60	Hz	(analogni	ulaz)
1920	x	1200	pri	60	Hz	(digitalni	ulaz)

  Preporučena rezolucija
1920	x	1200	pri	60	Hz	(digitalni	ulaz)

H. frekvencija 
(kHz)

Rezolucija V. frekvencija 
(Hz)

31,47 720x400 70,09
31,47 640x480 59,94
35,00 640x480 66,67
37,86 640x480 72,81
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
44,77 1280x720 59,86
63,89 1280x1024 60,02
79,98 1280x1024 75,03
55,94 1440x900 59,89
70,64 1440x900 74,98
64,67 1680x1050 59,88
65,29 1680x1050 59,95
66,59 1920x1080 59,93
74,04 1920×1200 59,95
67,50 1920x1080 60,00
75,00 1600×1200 60,00

  Beleška
Molimo	imajte	u	vidu	da	vaš	ekran	radi	najbolje	
u	osnovnoj	rezoluciji	od	1920	X	1200	pri	
60Hz.	Za	najbolji	prikaz,	molimo	koristite	ovu	
rezoluciju.

http://www.philips.com/support
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5. Štednja energije
Ukoliko	imate	VESA	DPM	karticu	o	saglasnosti	
sa	ekranom	ili	softver	instaliran	na	svom	
računaru,	monitor	može	automatski	smanjiti	
potrošnju	električne	energije	kada	ga	ne	
koristite.	Ukoliko	se	detektuje	unos	sa	tastature,	
miša	ili	sa	drugog	uređaja	za	unos,	monitor	će	se	
automatski	'probuditi'.	Naredna	tabela	pokazuje	
potrošnju	elektricne	struje	i	signalizaciju	ove	
osobine	automatske	štednje	elektricne	energije:

Definicija	upravljanja	potrošnjom	električne	energije

VESA	režim Video H-sync	 V-sync	 Električna	energija	u	upotrebi
Boja	svetleće	

diode	

Aktivno UKLJUČENO Da Da 	29,8W	(tip.)	 
48	W	(maks.) Belo

Spavanje	
(vreme	
čekanja)

ISKLJUČENO Ne Ne <0,3W Belo 
(trepćuće)	

Isključi ISKLJUČENO - - <0,2	W ISKLJUČENO

Sledeće	podešavanje	se	koristi	da	izmeri	
potrošnju	energije	ovog	monitora.

•	 Nativna	rezolucija:	1920	×	1200
•	 Kontrast:	50%
•	 Osvetljenje:	250	nita
•	 Temperatura	boje:	6500k	sa	punom	belom	

šemom

  Beleška
Ovi	podaci	se	mogu	menjati	bez	obaveštenja.
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Congratulations!
This	product	is	designed	for	both	you	and	the	
planet!	

TCO	Development	works	for	
sustainable	IT	-	manufacture,	
use	and	recycling	of	IT	products	

reflecting	environmental,	social	and	economic	
responsibility.

TCO	Certified	is	a	third	party	verified	program,	
where	every	product	model	is	tested	by	an	
accredited	impartial	test	laboratory.	TCO	
Certified	represents	one	of	the	toughest	
certifications	for	ICT	products	worldwide.	

Some of the Usability features of TCO 
Certified Displays: 

•	 Visual	Ergonomics	for	image	quality 
is	tested	to	ensure	top	performance 
and	reduce	sight	and	strain	problems.	
Important	parameters	are	Resolution,	
Luminance,	Contrast,	Reflection	and	Colour	
characteristics

•	 Products	are	tested	according	to	rigorous	
safety	standards	at	impartial	laboratories

•	 Electric	and	magnetic	fields	emissions	as	
low	as	normal	household	background	levels

•	 Workload	ergonomics	to	ensure	a	good	
physical	environment

Some of the Environmental features of TCO 
Certified Displays: 

•	 Production	facilities	have	an	Environmental	
Management	System	(EMAS	or	ISO	14001)

•	 Low	energy	consumption	to	minimize	
climate impact

•	 Restrictions	on	Chlorinated	and	
Brominated	flame	retardants,	plasticizers,	
plastics	and	heavy	metals	such	as	cadmium,	
mercury	and	lead	(RoHS	compliance)

•	 Both	product	and	product	packaging	is	
prepared	for	recycling

•	 The	brand	owner	offers	take-back	options

Corporate Social Responsibility

•	 The	brand	owner	demonstrates	the	
product	is	manufactured	under	working	
practices	that	promote	good	labour	
relations	and	working	conditions.

The	Criteria	Document	can	be	downloaded	
from	our	web	site.	The	criteria	included	in	
this	label	have	been	developed	by	TCO	
Development	in	co-operation	with	scientists,	
experts,	users	as	well	as	manufacturers	all	
over	the	world.	Since	the	end	of	the	1980s	
TCO	has	been	involved	in	influencing	the	
development	of	IT	equipment	in	a	more	user	
and	environmentally	friendly	direction.	Our	ICT	
product	labeling	system	began	in	1992	and	is	
now	requested	by	users	and	ICT-manufacturers	
all	over	the	world.	

For	displays	with	glossy	bezels,	the	user	should	
consider	the	placement	of	the	display	as	the	
bezel	may	cause	disturbing	reflections	from	
surrounding	light	and	bright	surfaces.

For	more	information,	please	visit:		www.
tcodevelopment.com

Technology for you and the planet

(Only	for	selective	models)

User	define	mode	is	used	for	TCO	Certified	
compliance.
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Lead-free Product
Lead	free	display	promotes	
environmentally	sound	recovery	
and	disposal	of	waste	from	electrical	
and	electronic	equipment.	Toxic	

substances	like	Lead	has	been	eliminated	
and	compliance	with	European	community’s	
stringent	RoHs	directive	mandating	restrictions	
on	hazardous	substances	in	electrical	and	
electronic	equipment	have	been	adhered	to	
in	order	to	make	Philips	monitors	safe	to	use	
throughout	its	life	cycle.

EPEAT
(www.epeat.net)

The	EPEAT	(Electronic	
Product	Environmental	
Assessment	Tool)	program	
evaluates computer 

desktops,	laptops,	and	monitors	based	on	51	
environmental	criteria	developed	through	
an	extensive	stakeholder	consensus	process	
supported	by	US	EPA.

EPEAT	system	helps	purchasers	in	the	public	
and	private	sectors	evaluate,	compare	and	
select	desktop	computers,	notebooks	and	
monitors	based	on	their	environmental	
attributes.	EPEAT	also	provides	a	clear	and	
consistent	set	of	performance	criteria	for	the	
design	of	products,	and	provides	an	opportunity	
for	manufacturers	to	secure	market	recognition	
for	efforts	to	reduce	the	environmental	impact	
of	its	products.

Benefits of EPEAT
Reduce	use	of	primary	materials 
Reduce	use	of	toxic	materials

Avoid	the	disposal	of	hazardous	waste	EPEAT’S	
requirement	that	all	registered	products	meet	
ENERGY	STAR’s	energy	efficiency	specifications,	
means	that	these	products	will	consume	less	
energy	throughout	their	life.

CE Declaration of Conformity
This	product	is	in	conformity	with	the	following	
standards	

•	 EN60950-1:2006+A11:2009+A1:20
10+A12:2011	(Safety	requirement	of	
Information	Technology	Equipment).

•	 EN55022:2010	(Radio	Disturbance	
requirement	of	Information	Technology	
Equipment).

•	 EN55024:2010	(Immunity	requirement	of	
Information	Technology	Equipment).

•	 EN61000-3-2:2006	+A1:2009+A2:2009	
(Limits	for	Harmonic	Current	Emission).

•	 EN61000-3-3:2008	(Limitation	of	Voltage	
Fluctuation	and	Flicker)	following	provisions	
of	directives	applicable.

•	 EN	50581:2012	(Technical	documentation	
for	the	assessment	of	electrical	and	
electronic	products	with	respect	to	the	
restriction	of	hazardous	substances)	

•	 EN	50564:2011	(Electrical	and	electronic	
household	and	office	equipment	—	
Measurement	of	low	power	consumption)

•	 2006/95/EC	(Low	Voltage	Directive).
•	 2004/108/EC	(EMC	Directive).
•	 2009/125/EC	(ErP	Directive,	EC	No.	

1275/2008	Implementing	Directive	
for	Standby	and	Off	mode	power	
consumption)	and	is	produced	by	a	
manufacturing	organization	on	ISO9000	
level.

•	 2011/65/EU	(RoHS	Directive)	and	is	
produced	by	a	manufacturing	organization	
on	ISO9000	level.

The	product	also	comply	with	the	following	
standards	

•	 ISO9241-307:2008	(Ergonomic	
requirement,	Analysis	and	compliance	test	
methods	for	electronic	visual	displays).

•	 GS	EK1-2000:2013	(GS	mark	requirement).
•	 prEN50279:1998	(Low	Frequency	Electric	

and	Magnetic	fields	for	Visual	Display).

www.epeat.net
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•	 MPR-II	(MPR:1990:8/1990:10	Low	
Frequency	Electric	and	Magnetic	fields).

Energy Star Declaration
(www.energystar.gov)

As	an	ENERGY	STAR®	Partner,	we	
have	determined	that	this	product	
meets	the	ENERGY	STAR® 
guidelines	for	energy	efficiency.

 Note
We	recommend	you	switch	off	the	monitor	
when	it	is	not	in	use	for	a	long	time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)
	 This	equipment	has	been	tested	and	found	
to	comply	with	the	limits	for	a	Class	B	digital	
device,	pursuant	to	Part	15	of	the	FCC	
Rules.	These	limits	are	designed	to	provide	
reasonable	protection	against	harmful	
interference	in	a	residential	installation.	
This	equipment	generates,	uses	and	can	
radiate	radio	frequency	energy	and,	if	not	
installed	and	used	in	accordance	with	the	
instructions,	may	cause	harmful	interference	
to	radio	communications.	 
 
However,	there	is	no	guarantee	that	
interference	will	not	occur	in	a	particular	
installation.	If	this	equipment	does	cause	
harmful	interference	to	radio	or	television	
reception,	which	can	be	determined	by	
turning	the	equipment	off	and	on,	the	
user	is	encouraged	to	try	to	correct	
the	interference	by	one	or	more	of	the	
following	measures:	

•	 Reorient	or	relocate	the	receiving	antenna.
•	 Increase	the	separation	between	the	

equipment	and	receiver.
•	 Connect	the	equipment	into	an	outlet	on	

a	circuit	different	from	that	to	which	the	
receiver	is	connected.

•	 Consult	the	dealer	or	an	experienced	
radio/TV	technician	for	help.

	 Changes	or	modifications	not	expressly	
approved	by	the	party	responsible	for	
compliance	could	void	the	user's	authority	
to	operate	the	equipment.

Use	only	RF	shielded	cable	that	was	supplied	
with	the	monitor	when	connecting	this	monitor	
to	a	computer	device.	

To	prevent	damage	which	may	result	in	fire	or	
shock	hazard,	do	not	expose	this	appliance	to	
rain	or	excessive	moisture.	

THIS	CLASS	B	DIGITAL	APPARATUS	MEETS	
ALL	REQUIREMENTS	OF	THE	CANADIAN	
INTERFERENCE-CAUSING	EQUIPMENT	
REGULATIONS.

FCC Declaration of Conformity
Declaration	of	Conformity	for	Products	Marked	
with	FCC	Logo,	

United States Only

This	device	complies	with	Part	15	of	the	FCC	
Rules.	Operation	is	subject	to	the	following	two	
conditions:	(1)	this	device	may	not	cause	harmful	
interference,	and	(2)	this	device	must	accept	any	
interference	received,	including	interference	that	
may	cause	undesired	operation.	

Commission Federale de la Communication 
(FCC Declaration)
	 Cet	équipement	a	été	testé	et	déclaré	
conforme	auxlimites	des	appareils	
numériques	de	class	B,aux	termes	de	
l'article	15	Des	règles	de	la	FCC.	Ces	
limites	sont	conçues	de	façon	à	fourir	
une	protection	raisonnable	contre	les	
interférences	nuisibles	dans	le	cadre	d'une	
installation	résidentielle.	 
 
CET	appareil	produit,	utilise	et	peut	émettre	
des	hyperfréquences	qui,	si	l'appareil	n'est	
pas	installé	et	utilisé	selon	les	consignes	
données,	peuvent	causer	des	interférences	
nuisibles	aux	communications	radio.	 

http://www.energystar.gov
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Cependant,	rien	ne	peut	garantir	l'absence	
d'interférences	dans	le	cadre	d'une	
installation	particulière.	Si	cet	appareil	est	
la	cause	d'interférences	nuisibles	pour	
la	réception	des	signaux	de	radio	ou	de	
télévision,	ce	qui	peut	être	décelé	en	
fermant	l'équipement,	puis	en	le	remettant	
en	fonction,	l'utilisateur	pourrait	essayer	de	
corriger	la	situation	en	prenant	les	mesures	
suivantes:

•	 Réorienter	ou	déplacer	l’antenne	de	
réception.

•	 Augmenter	la	distance	entre	l’équipement	
et le récepteur.

•	 Brancher	l’équipement	sur	un	autre	circuit	
que celui utilisé par le récepteur.

•	 Demander	l’aide	du	marchand	ou	d’un	
technicien	chevronné	en	radio/télévision.
	 Toutes	modifications	n'ayant	pas	reçu	
l'approbation	des	services	compétents	
en	matière	de	conformité	est	susceptible	
d'interdire	à	l'utilisateur	l'usage	du	présent	
équipement.

N'utiliser	que	des	câbles	RF	armés	pour	
les	connections	avec	des	ordinateurs	ou	
périphériques. 

CET	APPAREIL	NUMERIQUE	DE	LA	CLASSE	
B	RESPECTE	TOUTES	LES	EXIGENCES	DU	
REGLEMENT	SUR	LE	MATERIEL	BROUILLEUR	
DU	CANADA.	

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice
The	equipment	should	draw	power	from	a	
socket	with	an	attached	protection	circuit	(a	
three-prong	socket).	All	equipment	that	works	
together	(computer,	monitor,	printer,	and	so	on)	
should	have	the	same	power	supply	source.

The	phasing	conductor	of	the	room's	electrical	
installation	should	have	a	reserve	short-circuit	
protection	device	in	the	form	of	a	fuse	with	a	
nominal	value	no	larger	than	16	amperes	(A).

To	completely	switch	off	the	equipment,	the	
power	supply	cable	must	be	removed	from	the	
power	supply	socket,	which	should	be	located	
near	the	equipment	and	easily	accessible.

A	protection	mark	"B"	confirms	that	the	
equipment	is	in	compliance	with	the	protection	
usage	requirements	of	standards	PN-93/T-42107	
and	PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation	
VARNING:
FÖRSÄKRA	DIG	OM	ATT	HUVUDBRYTARE	
OCH	UTTAG	ÄR	 LÄTÅTKOMLIGA,	NÄR	
DU	STÄLLER	DIN	UTRUSTNING	PÅPLATS.

Placering/Ventilation	
ADVARSEL:  
SØRG	VED	 PLACER INGEN	 FOR ,	 AT	
NETLEDNINGENS	STIK	OG	STIKKONTAKT	
ER	NEMT	TILGÆNGELIGE.	

Paikka/Ilmankierto	
VAROITUS:  
SIJOITA	LAITE	SITEN,	ETTÄ	VERKKOJOHTO	
VOIDAAN	TARVITTAESSA	 HELPOSTI	
IRROTTAA	PISTORASIASTA.	

Plassering/Ventilasjon	
ADVARSEL: 
NÅR	DETTE	UTSTYRET	 PLASSERES,	MÅ	
DU	 PASSE	 PÅ	AT	 KONTAKTENE	 FOR	
STØMTILFØRSEL	ER	LETTE	Å	NÅ.

Ergonomie Hinweis (nur Deutschland)
Der	von	uns	gelieferte	Farbmonitor	entspricht	
den	in	der	"Verordnung	über	den	Schutz	vor	
Schäden	durch	Röntgenstrahlen"	festgelegten	
Vorschriften.	

Auf	der	Rückwand	des	Gerätes	befindet	sich	
ein	Aufkleber,	der	auf	die	Unbedenklichkeit	der	
Inbetriebnahme	hinweist,	da	die	Vorschriften	
über	die	Bauart	von	Störstrahlern	nach	Anlage	
III	¤	5	Abs.	4	der	Röntgenverordnung	erfüllt	sind.	

Damit	Ihr	Monitor	immer	den	in	der	Zulassung	
geforderten	Werten	entspricht,	ist	darauf	zu	
achten,	daß	

1. Reparaturen	nur	durch	Fachpersonal	
durchgeführt	werden.	

2. 	nur	original-Ersatzteile	verwendet	werden.	
3. 	bei	Ersatz	der	Bildröhre	nur	eine	

bauartgleiche	eingebaut	wird.	

Aus	ergonomischen	Gründen	wird	empfohlen,	
die	 Grundfarben	 Blau	 und	 Rot	 nicht	 auf	
dunklem	Untergrund	zu	verwenden	(schlechte	
Lesbarkeit	und	erhöhte	Augenbelastung	bei	zu	
geringem	Zeichenkontrast	wären	die	Folge).	
Der	 arbeitsplatzbezogene	 Schalldruckpegel	
nach	DIN	 45	 635	 beträgt	 70dB	 (A)	 oder	
weniger.	

 ACHTUNG:	BEIM	AUFSTELLEN	
DIESES	GERÄTES	DARAUF	
ACHTEN,	DAß	NETZSTECKER	UND	
NETZKABELANSCHLUß	LEICHT	
ZUGÄNGLICH	SIND.	
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Restriction on Hazardous Substances 
statement (India)

This	product	complies	with	the	“India	E-waste	
Rule	2011”	and	prohibits	use	of	lead,	mercury,	
hexavalent	chromium,	polybrominated	
biphenyls	or	polybrominated	diphenyl	ethers	
in	concentrations	exceeding	0.1	weight	%	and	
0.01	weight	%	for	cadmium,	except	for	the	
exemptions	set	in	Schedule	2	of	the	Rule.

E-Waste Declaration for India

This	symbol	on	the	product	or	on	its	packaging	
indicates	that	this	product	must	not	be	
disposed	of	with	your	other	household	waste.	
Instead	it	is	your	responsibility	to	dispose	of	
your	waste	equipment	by	handing	it	over	to	
a	designated	collection	point	for	the	recycling	
of	waste	electrical	and	electronic	equipment	.	
The	separate	collection	and	recycling	of	your	
waste	equipment	at	the	time	of	disposal	will	
help	to	conserve	natural	resources	and	ensure	
that	it	is	recycled	in	a	manner	that	protects	
human	health	and	the	environment.	For	more	
information	about	where	you	can	drop	off	your	
waste	equipment	for	recycling	in	India	please	
visit	the	below	web	link.

http://www.india.philips.com/about/sustainability/
recycling/index.page

China RoHS 
The	People's	Republic	of	China	released	a	
regulation	called	"Management	Methods	for	
Controlling	Pollution	by	Electronic	Information	
Products"	or	commonly	referred	to	as	China	
RoHS.	All	products	produced	and	sold	for	China	
market	have	to	meet	China	RoHS	request.

中国电子信息产品污染控制标识要求(中国
RoHS法规标示要求)产品中有毒有害物质或
元素的名称及含量

部件名称

有毒有害物质或元素

铅 
(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬 
(Cr6+)

多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

外壳 O O O O O O

液晶显示屏/灯管 X O O O O O

电路板组件* X O O O O O

电源适配线 X O O O O O

电源线/连接线 X O O O O O

*:  电路板组件包括印刷电路板及其构成的零部件，如电阻、电容、集成电
路、连接器等。

O:  表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T26572-2011
规定的限量要求以下。

X:  表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/
T26572-2011规定的限量要求；但是上表中打“X”的部件，符合欧盟RoHS法
规要求（属于豁免的部分）。

环保使用期限

此标识指期限(十年),电子信息产品中含有
的有毒有害物质或元素在正常使用的条件
下不会发生外泄或突变,电子信息产品用户
使用该电子信息产品不会对环境造成严重
污染或对其人身、财产造成严重损害的期
限。

《废弃电器电子产品回收处理管理条例》
提示性说明

为了更好地关爱及保护地球，当用户不再
需要此产品或产品寿命终止时，请遵守国
家废弃电器电子产品回收处理相关法律法
规，将其交给当地具有国家认可的回收处
理资质的厂商进行回收处理。
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7. Briga o kupcima i garancija

7.1 Politika kompanije Philips na 
području defektnih piksela na 
pljosnatim monitorima

Philips	nastoji	da	isporuči	proizvode	najvišeg	
kvaliteta.	Mi	koristimo	neke	od	najsavremenijih	
proizvodnih	procesa	u	našoj	branši	i	sprovodimo	
strogu	kontrolu	kvaliteta.	Međutim,	defekti	
piksela	i	sub-piksela	na	IPS	LCD	pločama	koje	
se	koriste	u	ravnim	monitorima	ponekad	
su	neizbežni.	Nijedan	proizvođač	ne	može	
garantovati	da	paneli	neće	imati	defektne	
piksele,	a	Philips	garantuje	da	će	svaki	monitor	
koji	ima	neprihvatljiv	broj	defekata	popraviti	ili	
zameniti	pod	garancijom.	U	ovom	obaveštenju	
opisani	su	tipovi	defekata	piksela	i	definisan	
prihvatljiv	nivo	defekata	za	svaki	tip.	Da	bi	
se	steklo	pravo	na	popravku	ili	zamenu	pod	
garancijom,	broj	defektnih	piksela	na	IPS	LCD	
ploči	mora	biti	iznad	ovih	prihvatljivih	nivoa.	Na	
primer,	ne	sme	da	nedostaje	više	od	0.0004%	
pod	piksela	na	monitoru.	Pošto	se	neki	tipovi	
i	kombinacije	tipova	defekata	piksela	više	
primećuju	nego	drugi,	Philips	je	za	njih	postavio	
čak	i	više	standarde	kvaliteta.	Ova	polica	važi	
svuda	u	svetu.

Pikseli i sub-pikseli
Piksel	ili	element	slike	sastoji	se	od	tri	sub-
piksela	primarne	boje	(crvene,	zelene	i	plave).	
Veliki	broj	piksela	zajedno	čini	sliku.	Kada	su	svi	
sub-pikseli	jednog	piksela	osvetljeni,	tri	obojena	
sub-piksela	zajedno	izgledaju	kao	jedinstveni	
piksel	bele	boje.	Kada	su	svi	tamni,	tri	obojena	
sub-piksela	zajedno	izgledaju	kao	jedinstveni	
piksel	crne	boje.	Druge	kombinacije	osvetljenih	

i	tamnih	sub-piksela	izgledaju	kao	jedinstveni	
piksel	neke	druge	boje.

Tipovi defektnih piksela
Defektni	pikseli	i	sub-pikseli	na	ekranu	
manifestuju	se	na	različite	načine.	Postoje	dve	
kategorije	defektnih	piksela	i	nekoliko	tipova	
defektnih	sub-piksela	u	svakoj	od	kategorija.

Defekti svetle tačke
Defekti	svetle	tačke	se	pojavljuju	kada	su	pikseli	
ili	podpikseli	uvek	uključeni	ili	osvetljeni.	To	jest,	
svetla	tačka	je	pod-piksel	koji	je	prikazan	na	
ekranu	kada	je	na	monitoru	tamni	dijagram.	
Postoje	različiti	tipovi	defekata	svetle	tačke.

Jedan	osvetljeni	sub-piksel	(crveni,	zeleni	ili	plavi).

Dva	susedna	osvetljena	sub-piksela:
-	 crveni	+	plavi	=	purpurni
-	 crveni	+	zeleni	=	žuti
-	 zeleni	+	plavi	=	cijan	(svetloplavi)

Tri	susedna	osvetljena	sub-piksela	(jedan	beli	
piksel).

podpiksel

piksela
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Blizina defektnih piksela
Pošto	se	defektni	pikseli	i	sub-pikseli	istog	tipa	
više	primećuju	kad	su	blizu	jedan	do	drugoga,	
Philips	je	specificirao	i	tolerancije	za	blizinu	
defektnih	piksela.

Tolerancije za defektne piksele
Da	bi	se	steklo	pravo	na	popravku	ili	zamenu	
pod	garancijom	zbog	defektnih	piksela,	IPS	LCD	
panel	u	ravnom	Philips	monitoru	mora	da	ima	
defektne	piksele	ili	sub-piksele	koji	premašuju	
tolerancije	navedene	u	sledećim	tabelama.

  Beleška
Crvena	ili	plava	svetla	tačka	mora	da	bude	više	
od	50	procenata	svetlija	u	odnosu	na	susedne	
tačke	dok	je	zelena	svetla	tačka	30	procenata	
svetlija	od	susednih	tačaka.

Defekti crne tačke
Defekti	crne	tačke	se	pojavljuju	kada	su	pikseli	ili	
podpikseli	uvek	isključeni	ili	tamni.	To	jest,	tamna	
tačka	je	pod-piksel	koji	je	prikazan	na	ekranu	
kada	je	na	monitoru	svetli	dijagram.	Ovo	su	
tipovi	defekata	crne	tačke.

OŠTEĆENJA SVETLE TAČKE PRIHVATLJIV NIVO
1	svetli	podpiksel 3
2	susedna	svetla	podpiksela 1
3	susedna	svetla	podpiksela	(jedan	beli	piksel) 0
Rastojanje	izmedu	dva	oštećenja	svetle	tačke* >15mm
Ukupno	oštećenja	svetle	tačke	svih	vrsta 3
OŠTEĆENJA CRNE TAČKE PRIHVATLJIV NIVO
1	tamni	podpiksel 5	ili	manje
2	susedna	tamna	podpiksela 2	ili	manje
3	susedna	tamna	podpiksela 0
Razdaljina	između	dva	oštećenja	crne	tačke* >15mm
Ukupno	oštećenja	crne	tačke	svih	vrsta 5	ili	manje
UKUPNO OŠTEĆENJA TAČKE PRIHVATLJIV NIVO
Ukupno	oštećenja	svetle	ili	crne	tačke	svih	vrsta 5	ili	manje

  Beleška
1. 1	ili	2	oštećena	susednih	podpiksela	=	1	oštećenje	tačke
2. Ovaj	monitor	je	u	saglasnosti	sa	ISO9241-307.	(ISO9241-307:	Egronomski	zahtev,	analize	i	metoda	

testiranja	saglasnosti	za	elektronsko	vizuelne	ekrane)
3. ISO9241-307	je	naslednik	ranije	poznatog	standarda	ISO13406,	koji	je	povukla	Međunarodna	

organizacija	za	standardizaciju	(ISO)	na	dan:	2008-11-13.
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7.2 Briga o kupcima & Garancija
Za	informacije	o	pokriću	garancije	i	zahtevu	za	dodatnu	podršku	za	vaš	region,	molimo	posetite	internet	
prezentaciju	www.philips.com/support	za	detalje.	Takođe	možete	kontaktirati	 svoj	 lokalni	broj	Philips	
centra	za	brigu	o	potrošačima	koji	se	nalazi	ispod.

Kontakt informacije za region ZAPADNE EVROPE:
Država ASC Broj pozivnog centra Cena Radno vreme
Austria RTS +43 0810 000206 € 0.07 Mon to Fri : 9am - 6pm

Belgium Ecare +32 078 250851 € 0.06 Mon to Fri : 9am - 6pm

Cyprus Alman 800 92 256 Free of charge Mon to Fri : 9am - 6pm

Denmark Infocare +45 3525 8761 Local call tariff Mon to Fri : 9am - 6pm

Finland Infocare  +358 09 2290 1908 Local call tariff Mon to Fri : 9am - 6pm

France Mainteq +33 082161 1658 € 0.09 Mon to Fri : 9am - 6pm

Germany RTS +49 01803 386 853 € 0.09 Mon to Fri : 9am - 6pm

Greece Alman +30 00800 3122 1223 Free of charge Mon to Fri : 9am - 6pm

Ireland Celestica +353 01 601 1161 Local call tariff Mon to Fri : 8am - 5pm

Italy Anovo Italy +39 840 320 041 € 0.08 Mon to Fri : 9am - 6pm

Luxembourg Ecare +352 26 84 30 00 Local call tariff Mon to Fri : 9am - 6pm

Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri : 9am - 6pm

Norway Infocare +47 2270 8250 Local call tariff Mon to Fri : 9am - 6pm

Poland MSI +48 0223491505 Local call tariff Mon to Fri : 9am - 6pm

Portugal Mainteq 800 780 902 Free of charge Mon to Fri : 8am - 5pm

Spain Mainteq +34 902 888 785 € 0.10 Mon to Fri : 9am - 6pm

Sweden Infocare +46 08 632 0016 Local call tariff Mon to Fri : 9am - 6pm

Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm

United Kingdom Celestica +44 0207 949 0069 Local call tariff Mon to Fri : 8am - 5pm

Kontakt informacije za Kinu:
Država Pozivni centar Broj servisa za kupce

China PCCW Limited 4008 800 008

Kontakt informacije za SEVERNU AMERIKU:
Država Pozivni centar Broj servisa za kupce

U.S.A. EPI-e-center	 (877)	835-1838
Canada EPI-e-center	 (800)	479-6696
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Kontakt informacije za region CENTRALNE I ZAPADNE EVROPE:

Država
Pozivni 
centar CSP Broj servisa za kupce

Belarus NA IBA
+375 17 217 3386 
+375 17 217 3389

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA MR Service Ltd +385 (01) 640 1111

Czech Rep. NA Asupport 420 272 188 300

Estonia NA FUJITSU
+372 6519900(General) 
+372 6519972(workshop)

Georgia NA Esabi +995 322 91 34 71

Hungary NA Profi Service

+36 1 814 8080(General) 
+36 1814 8565(For AOC&Philips 
only)

Kazakhstan NA Classic Service I.I.c. +7 727 3097515

Latvia NA ServiceNet LV
+371 67460399 
+371 27260399

Lithuania
NA

UAB Servicenet
+370 37 400160(general) 
+370 7400088 (for Philips)

Macedonia NA AMC +389 2 3125097

Moldova NA Comel +37322224035

Romania NA Skin +40 21 2101969

Russia NA CPS +7 (495) 645 6746

Serbia&Montenegro NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

the republic of Belarus NA ServiceBy + 375 17 284 0203

Turkey NA Tecpro +90 212 444 4 832 

Ukraine NA Topaz +38044 525 64 95

Ukraine NA Comel +380 5627444225

Kontakt informacije za region LATINSKE AMERIKE:
Država Pozivni centar Broj servisa za kupce

Brazil
Vermont	

0800-7254101
Argentina 0800 3330 856
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Kontakt informacije za APMEA region:
Država ASP Broj servisa za kupce Radno vreme
Australia AGOS NETWORK PTY LTD 1300 360 386 Mon.~Fri. 9:00am-5:30pm

New Zealand Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm

Hong Kong 
Macau

Company: Smart Pixels 
Technology Ltd.

Hong Kong: 
Tel: +852 2619 9639 
Macau:Tel: (853)-0800-987

Mon.~Fri. 9:00am-6:00pm  
Sat. 9:00am-1:00pm

India REDINGTON INDIA LTD
Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Mon.~Fri. 9:00am-5:30pm

Indonesia
PT. CORMIC SERVISINDO 
PERKASA

+62-21-4080-9086 (Customer 
Hotline) 
+62-8888-01-9086 (Customer 
Hotline)

Mon.~Thu. 08:30-12:00; 
13:00-17:30  
Fri. 08:30-11:30; 13:00-17:30

Korea Alphascan Displays, Inc 1661-5003
Mon.~Fri. 9:00am-5:30pm 
Sat. 9:00am-1:00pm

Malaysia R-Logic Sdn Bhd +603 5102 3336
Mon.~Fri. 8:15am-5:00pm 
Sat. 8:30am-12:30am

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore
Philips Singapore Pte Ltd 
(Philips Consumer Care 
Center)

(65) 6882 3966
Mon.~Fri. 9:00am-6:00pm 
Sat. 9:00am-1:00pm

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00

Thailand
Axis Computer System Co., 
Ltd.

(662) 934-5498 Mon.~Fri. 8:30am~05:30pm

South Africa Computer Repair Technologies 011  262 3586 Mon.~Fri.8:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00 

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi Minh 
City Branch

+84 8 38248007 Ho Chi Minh 
City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho 
Province

Mon.~Fri. 8:00-12:00, 13:30-
17:30,Sat. 8:00-12:00

Philippines
EA Global Supply Chain 
Solutions ,Inc.

(02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm

Armenia 
Azerbaijan 
Georgia 
Kyrgyzstan 
Tajikistan

Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Uzbekistan
Soniko Plus Private Enterprise 
Ltd

+99871 2784650 Mon.~Fri. 09:00 - 18:00

Turkmenistan Technostar Service Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00

Japan フィリップスモニター 
・サポートセンター 0120-060-530 Mon.~Fri. 10:00 - 17:00
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8. Rešavanje problema i 
najčešća pitanja

8.1 Rešavanje problema
Ova	stranica	se	bavi	problemima	koje	može	
rešiti	sam	korisnik.	Ukoliko	problem	postoji	i	
nakon	što	ste	probali	ova	rešenja,	kontaktirajte	
predstavnika	Philips	korisničkog	servisa.

  Uobičajeni problemi

Nema slike (svetleća dioda za napajanje ne gori)
•	 Proverite	da	li	je	električni	kabl	povezan	sa	

utičnicom	i	sa	zadnjim	delom	monitora.
•	 Prvo,	proverite	da	li	je	prekidač	za	

uključivanje	na	prednjem	delu	monitora	u	
položaju	ISKLJUČEN,	zatim	ga	pritisnite	u	
položaj	UKLJUČEN.

Nema slike (svetleća dioda za napajanje gori belo)
•	 Proverite	da	li	je	računar	uključen.
•	 Proverite	da	li	je	signalni	kabl	ispravno	

povezan	sa	vašim	računarom.
•	 Proverite	da	kabl	monitora	slučajno	nema	

savijene	čavlice	na	strani	sa	koje	se	spaja.	
Ukoliko	ima,	popravite	ili	zamenite	kabl.

•	 Osobina	štednje	energije	se	može	aktivirati

Ekran kaže
Attention

Check cable connection

•	 Proverite	da	li	je	kabl	monitora	ispravno	
povezan	sa	vašim	računarom.	(Takođe	
pogledajte	vodič	za	brzo	korišćenje).

•	 Proverite	da	vidite	da	li	kabl	monitora	ima	
savijene	čavlice.

•	 Proverite	da	li	je	računar	uključen.

AUTO taster ne funkcioniše
•	 Auto	funkcija	se	može	primeniti	samo	u	VGA-

Analog	(VGA-analognom)	režimu.	Ukoliko	
rezultat	nije	zadovoljavajući,	možete	da	uradite	
ručna	podešavanja	preko	menija	na	ekranu.

  Beleška
Auto	funkcija	ne	može	da	se	primeni	u	DVI-Digital	
(DVI-digitalnom)	režimu,	jer	nije	neophodna.

Vidljivi znaci dima ili varnica
•	 Ne	obavljajte	bilo	kakve	korake	za	

rešavanje	problema
•	 Odmah	isključite	monitor	iz	glavnog	izvora	

napajanja,	zbog	bezbednosti
•	 Odmah	kontaktirajte	predstavnika	Philips	

servisa	za	korisnike.

  Problemi sa slikom

Slika nije centrirana
•	 Podesite	poziciju	slike	koristeći	„Auto”	funkciju	

u	glavnim	kontrolama	menija	na	ekranu.
•	 Podesite	položaj	slike	koristeći	Phase/Clock	

(Faza	sinhronizacije)	Setup	(Podešavanja)	
u	OSD	Main	Controls	(OSD	glavnim	
kontrolama).	Radi	samo	u	VGA	režimu.

Slika vibrira na ekranu
•	 Proverite	da	li	je	signalni	kabl	sigurno	

povezan	sa	grafičkom	pločom	ili	računarom.

Vertikalno treperenje se javlja

•	 Podesite	poziciju	slike	koristeći	„Auto”	funkciju	
u	glavnim	kontrolama	menija	na	ekranu.

•	 Uklonite	vertikalne	pruge	koristeći	
Phase/Clock	(Faza	sinhronizacije)	Setup	
(Podešavanja)	u	OSD	Main	Controls	(OSD	
glavnim	kontrolama).	Radi	samo	u	VGA	režimu.

Horizontalno treperenje se javlja

•	 Podesite	poziciju	slike	koristeći	„Auto”	funkciju	
u	glavnim	kontrolama	menija	na	ekranu.

•	 Uklonite	vertikalne	pruge	koristeći	
Phase/Clock	(Faza	sinhronizacije)	Setup	
(Podešavanja)	u	OSD	Main	Controls	(OSD	
glavnim	kontrolama).	Radi	samo	u	VGA	režimu.
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javlja se zamrljana, nejasna ili suviše tamna slika
•	 Podesite	kontrast	i	svetlost	na	prikazu	na	ekranu.

„slika koja ostaje na ekranu”, „urezana slika” ili 
„fantomna slike” ostaje nakon isključenja napajanja.
•	 Neprekidno	prikazivanje	statične	slike	tokom	

dužeg	vremenskog	perioda	može	na	ekranu	
da	izazove	efekat	„urezana	slika”,	takođe	
poznat	kao	„slika	koja	ostaje	na	ekranu”	ili	
„fantomna	slika”.	„Urezana	slika”,	„slika	koja	
ostaje	na	ekranu”	ili	„fantomna	slika”	je	dobro	
poznati	fenomen	u	tehnologiji	panel	monitora.	
U	većini	slučajeva	„urezana	slika”,	„slika	koja	
ostaje	na	ekranu”	ili	„fantomna	slika”,	će	nestati	
nakon	nekog	vremena	od	isključenja	iz	struje.

•	 Prilikom	svakog	napuštanja	monitora,	
pokrenite	čuvara	ekrana.

•	 Uvek	aktivirajte	aplikaciju	za	osvežavanje	
periodičnog	ekrana	ukoliko	vaš	LCD	monitor	
pokazuje	nepromenljiv	statični	sadržaj.

•	 Neuspešno	pokretanje	čuvara	ekrana,	ili	
aplikacija	sa	periodičnim	osvežavanjem	ekrana	
mogu	dovesti	do	pojave	ozbiljnih	simptoma	
„urezana	slike”,	„slike	koja	ostaje	na	ekranu”	
ili	„fantomna	slike”,	koji	neće	nestati	i	koji	ne	
mogu	biti	popravljeni.	Oštećenje	pomenuto	
gore	nije	pokriveno	garancijom.

Pojavljuje se iskrivljena slika. Tekst je nejasan ili 
zamrljan.
•	 Podesite	rezoluciju	prikaza	računara	na	isti	

režim	kao	što	je	preporučena	originalna	
rezolucija	ekrana	monitora.

Zelene, crvene, plave, tamne, i bele tačke se 
javljaju na ekranu
•	 Preostale	tačke	su	normalna	karakteristika	

tečnog	kristala	koji	se	koristi	u	današnjoj	
tehnologiji.	Molimo	vas	pogledajte	politiku	o	
pikselima	za	više	detalja.

Svetlo za „uključeno napajanje” je isuviše jako i 
uznemiravajuće
•	 Možete	da	podesite	svetlo	za	„uključeno	

napajanje”	koristeći	podešavanje	za	svetleću	
diodu	za	napajanje,	u	glavnim	kontrolama	
menija	na	ekranu.

Za	dalju	pomoć,	pogledajte	spisak	Korisničkih	
centara	i	kontaktirajte	predstavnika	Philips	
korisničkog	servisa.

8.2 Najčešće postavljana pitanja za 
SmartControl Premium

P1.  Zamenim monitor za kompjuter 
drugim i SmartControl Premium ne 
može da se koristi, šta da radim?

Odg.:  Restartujte	svoj	kompjuter	i	pogledajte	da	li	
SmartControl	Premium	radi.	U	suprotnom,	
potrebno	je	da	uklonite	i	reinstalirate	
SmartControl	Premium	da	biste	osigurali	
da	je	instaliran	odgovarajući	drajver.

P2.  SmartControl Premium funkcije su 
ranije radile dobro, ali sada više ne 
rade, šta da radim?

Odg.:  Ukoliko	su	obavljene	sledeće	radnje,	možda	
je	potrebno	reinstalirati	drajver	monitora.

•	 Promenite	video	grafički	adapter	drugim
•	 Ažurirajte	video	drajver
•	 Radnje	na	OS,	kao	što	su	servisni	paket	ili	

zakrpa
•	 Pokrenite	Ažuriranje	Windows	sistema	i	

ažurirani	monitor	i/ili	video	drajver
•	 Windows	je	isključen	kada	je	monitor	

isključen	ili	izvučen	iz	struje.
•	 Da	saznate,	desnim	klikom	idite	na	My	

Computer	(Moj	računar)	i	kliknite	na	
Properties->Hardware->	Device	Manager	
(Svojstva->Hardver->Menadžer	uređaja).

•	 Ako	vidite	da	se	„Plug	and	Play	Monitor”	
(Monitor	koji	se	priključi	i	radi)	javlja	pod	
Monitor,	onda	morate	da	reinstalirate.	
Jednostavno	uklonite	SmartControl	
Premium	i	reinstalirajte	ga.

P3.  Nakon instaliranja SmartControl 
Premium, kada kliknem na SmartControl 
Premium tabelu, ništa se ne pokazuje 
nakon nekog vremena ili se pokaže 
poruka sa greškom o kvaru, šta se desilo?



40

8. Rešavanje problema i najčešća pitanja

Odg.:  Moguće	je	da	vaš	grafički	adapter	nije	
kompatibilan	sa	SmartControl	Premium.	
Ukoliko	je	vaš	grafički	adapter	jedan	od	
gore	pomenutih	brendova,	pokušajte	
da	preuzmete	najnoviji	drajver	za	
grafički	adapter	sa	internet	prezentacije	
odgovarajuće	kompanije.	Instalirajte	drajver.	
Uklonite	SmartControl	Premium	i	ponovo	
ga	reinstalirajte.
Ukoliko	još	uvek	ne	radi,	žao	nam	je	što	
grafički	adapter	nije	podržan.	Molimo	vas,	
posetite	Philips	internet	prezentaciju	i	
proverite	da	li	je	ažurirani	SmartControl	
Premium	drajver	dostupan.

P4.  Kada kliknem na Product Information 
(Informacije o proizvodu), samo se javlja 
delimična informacija, šta se desilo?

Odg.:  Može	biti	da	drajver	adaptera	vaše	
grafičke	kartice	nije	najnovija	verzija	koja	
potpuno	podržava	DDC/CI	interfejs.	
Pokušajte	da	preuzmete	najnoviji	
drajver	grafičkog	adaptera	sa	internet	
prezentacije	odgovarajuće	kompanije.	
Instalirajte	drajver.	Uklonite	SmartControl	
Premium	i	ponovo	ga	reinstalirajte.

Attention

Theft Deterrence is Enabled

P5.  Zaboravio sam svoj PIN za funkciju 
Theft Deterrence (Sprečavanje krađe). 
Kako to da rešim?

Odg.:  Philips	servisni	centar	ima	pravo	da	traži	
legitimnu	identifikaciju	i	ovlašćenje,	kako	
bi	ustanovio	vlasništvo	nad	monitorom.

8.3 Opšta FAQs (često postavljana 
pitanja)

P1:  Kada instaliram monitor, šta treba da 
uradim ukoliko je na ekranu prikazano 
„Cannot display this video mode” (nije 
moguće prikazati ovaj video režim)?

Odg.:  Preporučena	rezolucija	za	ovaj	monitor :	
1920	x	1200	pri	60	Hz

•	 Isključite	sve	kablove,	zatim	povežite	svoj	
računar	sa	monitorom	koji	ste	prethodno	
koristili.

•	 U	Windows	Start	(Početak)	Meniju,	izaberite	
Settings/Control	Panel	(Podešavanja/
kontrolni	panel).	U	Control	Panel	(kontrolni	
panel)	prozoru,	izaberite	ikonu	Display	
(prikaz).	Unutar	Display	Control	Panel	
(kontrolnog	panela	za	ekran),	izaberite	
prozorčić	'Settings'	(podešavanja).	Pod	
tabelom	za	podešavanja,	u	kvadratiću	sa	
oznakom	„Desktop	Area”	(Desktop	oblast),	
pomerite	klizač	na	1920	x	1200	piksela.

•	 Otvorite	'Advanced	Properties'	(napredne	
opcije)	i	podesite	brzinu	osvežavanja	na	
60Hz,	zatim	kliknite	na	OK.

•	 Restartujte	svoj	računar	i	ponovite	korake	
2	i	3,	da	potvrdite	da	je	vaš	računar	
podešen	na	1920	x	1200	pri	60	Hz.

•	 Isključite	svoj	kompjuter,	isključite	svoj	stari	
monitor	i	povežite	svoj	Philips	LCD	monitor.

•	 Uključite	monitor,	a	zatim	uključite	računar.

P2:  Koji je preporučeni opseg za 
osvežavanje za LCD monitor?

Odg.:  Preporučena	brzina	osvežavanja	za	
monitore	je	60Hz.	U	slučaju	nekih	
smetnji	na	ekranu,	možete	je	podesiti	na	
75Hz	da	vidite	da	li	to	uklanja	smetnje.

P3:  Šta su .inf i .icm fajlovi na CD-ROM-u? 
Kako instaliram drajvere (.inf i .icm)?

Odg.:  Ovo	su	fajlovi	drajvera	za	vaš	monitor.	
Sledite	uputstva	u	svom	priručniku	za	
korisnike	kako	biste	instalirali	drajvere.	
Vaš	računar	može	od	vas	tražiti	drajvere	
za	monitor	(.inf	i	.icm	fajlovi)	ili	disk	
drajver,	kada	prvi	put	instalirate	monitor.	
Sledite	uputstva	da	ubacite	(CD-ROM	
priručnik)	koji	ste	dobili	u	pakovanju.	
Drajveri	za	monitor	(.inf	i	.icm	fajlovi)	će	
biti	automatski	instalirani.

P4:  Kako podešavam rezoluciju?
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Odg.:  Drajver	za	vašu	video	karticu/grafiku	i	monitor	
zajedno	određuju	dostupne	rezolucije.	
Možete	izabrati	željenu	rezoluciju	u	okviru	
opcije	„Display	properties”	(svojstva	prikaza)	
Windows®	Control	Panel-a	(Windows® 

kontrolne	table).

P5:  Šta ako se izgubim kada obavljam 
podešavanja za monitor?

Odg.:  Jednostavno	pritisnite	taster	OK	,	zatim	
izaberite	„Reset”	(Resetuj)	da	vratite	sva	
originalna	fabrička	podešavanja.

P6:  Da li je LCD ekran otporan na ogrebotine?
Odg.:  Generalno	se	preporučuje	da	se	površina	

ploče	ne	izlaže	preteranim	udarima	i	da	
se	zaštiti	od	oštrih	ili	tupih	predmeta.	
Kada	rukujete	monitorom,	proverite	da	
nema	pritiska	ili	sile	na	površini	ploče.	
Ovo	može	uticati	na	uslove	garancije.

P7:  Kako bi trebalo da čistim površinu LCD-a?
Odg.:  Za	normalno	čišćenje,	koristite	čistu,	

mekanu	tkaninu.	Za	dubinsko	čišcenje,	
koristite izopropil alkohol. Ne koristite 
druge	rastvarače,	kao	što	su	etil	alkohol,	
etanol,	aceton,	heksan,	itd.

P8:  Mogu li da promenim podešavanje boje 
svog monitora?

Odg.:  Da,	možete	promeniti	svoje	podešavanje	
boja	putem	kontrola	menija	na	ekranu,	
na	sledeći	način,

•	 Pritisnite	„OK”	da	biste	prikazali	meni	na	
ekranu	(OSD).

•	 Pritisnite	taster	„Down	Arrow”	(Strelica	
nadole)	da	biste	odabrali	opciju	„Color”	
(Boja),	a	potom	pritisnite	taster	„OK”	da	
biste	pristupili	podešavanjima	za	boju,	
gde	se	nalaze	tri	podešavanja,	kao	što	je	
prikazano	u	nastavku.
1.	 Color	Temperature	(Temperatura	boje):	

Šest	podešavanja	su	5000K,	6500K,	
7500K,	8200K,	9300K	i	11500K.	Sa	
podešavanjima	u	opsegu	od	5000K	
ekran	izgleda	‘toplo,'	sa	tonom	crveno-

bele	boje,	dok	temperatura	od	11500K	
daje	‘hladan,	plavo-beli	ton.

2.	 sRGB:	Ovo	je	standardno	podešavanje	
za	obezbeđivanje	tačne	razmene	boja	
između	različitih	uređaja	(npr.	digitalni	foto-
aparati,	monitori,	štampači,	skeneri,	itd)

3. User	Define	(Korisnički	definisano):	
Korisnik	može	birati	svoju	omiljenu	boju	
podešavanja	podešavanjem	crvene,	
zelene	plave	boje.

  Beleška
Merenje	boje	svetla	koje	zrači	neki	predmet	dok	
se	zagreva.	Ovo	merenje	se	izražava	apsolutnom	
skalom,	(stepeni	u	Kelvinima).	Niže	temperature	
u	Kelvinima	kao	što	su	one	od	2004K	su	crvene;	
više	temperature	kao	što	su	one	od	9300K	su	
plave.	Neutralna	temperatura	je	bela,	na	6504K.

P9:  Da li mogu da povežem moj LCD 
monitor za bilo koji kompjuter, radnu 
stanicu ili Mac?

Odg.:  Da.	Svi	Philips	LCD	monitori	su	u	
potpunosti	kompatibilni	sa	standardnim	
kompjuterima,	Mac-ovima	i	radnim	
stanicama.	Može	vam	zatrebati	adapter	
za	kabl	da	povežete	monitor	sa	svojim	
mekintoš	sistemom.	Kontaktirajte	svog	
predstavnika	za	Philips	prodaju	za	više	
informacija.

P10:  Da li su Philips monitori uključi i 
reprodukuj?

Odg.:  Da,	monitori	su	Plug-and-Play	
kompatibilni	sa	sistemima	Windows	8/7/
Vista/XP/NT,	Mac	OSX	i	Linux

P11:  Sta je senka slike na LCD panelima?

Odg.:  Neprekidno	prikazivanje	statične	slike	
tokom	dužeg	vremenskog	perioda	
može	da	izazove	efekat	„Urezana	slika”,	
poznatiji	i	kao	„slika	koja	ostaje	na	
ekranu”	ili	„fantomna	slika”	na	ekranu.	
„Urezana	slika”,	„slika	koja	ostaje	na	
ekranu”	ili	„fantomna	slika”	je	dobro	
poznati	fenomen	u	tehnologiji	panel	
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monitora.	U	većini	slučajeva	„urezana	
slika”,	„slika	koja	ostaje	na	ekranu”	ili	
„fantomna	slika”,	će	nestati	nakon	nekog	
vremena	od	isključenja	iz	struje.
Prilikom	svakog	napuštanja	monitora,	
pokrenite	čuvara	ekrana.
Uvek	aktivirajte	aplikaciju	za	osvežavanje	
periodičnog	ekrana	ukoliko	vaš	LCD	
monitor	pokazuje	nepromenljiv	statični	
sadržaj.

  Upozorenje
Neuspešno	pokretanje	čuvara	ekrana,	ili	
aplikacija	sa	periodičnim	osvežavanjem	ekrana	
mogu	dovesti	do	pojave	ozbiljnih	simptoma	
„urezana	slike”,	„slike	koja	ostaje	na	ekranu”	ili	
„fantomna	slike”,	koji	neće	nestati	i	koji	ne	mogu	
biti	popravljeni.	Oštećenje	pomenuto	gore	nije	
pokriveno	garancijom.

P12:  Zašto moj ekran ne prikazuje oštar 
tekst, a prikazuje zupčasta slova?

Odg.:  Vaš	LCD	monitor	radi	najbolje	pri	
nativnoj	rezoluciji	od	1920	x	1200	
pri	60Hz.	Za	najbolji	prikaz,	molimo	
koristite	ovu	rezoluciju.
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